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About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

(J Important Safety Instructions (paper manual)
Provides you with instructions to ensure the safe use of this printer.
(4 Start Here (paper manual)
Provides you with information on setting up the printer and installing the software.
(1 User's Guide (digital manual)
This manual. Provides overall information and instructions on using the printer and on solving problems.
[d Administrator's Guide (digital manual)

Provides network administrators with information on management and printer settings.

You can obtain the latest versions of the above manuals with the following methods.

(d Paper manual

Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

(1 Digital manual

Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information

= “Software Update Tools (Software Updater)” on page 94

Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific
sections using the bookmarks. You can also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.


http://www.epson.eu/Support
http://support.epson.net/
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Searching by keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you want to find in the search window,
and then click Search. Hits are displayed as a list. Click one of the displayed hits to jump to that page.
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Jumping directly from bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous
page, perform the following operation on your keyboard.

(4 Windows: Hold down Alt, and then press <.
(4 Mac OS: Hold down the command key, and then press <.

User's Guide

Printing only the pages you need

You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you
want to print in Pages in Pages to Print.

[ To specity a series of pages, enter a hyphen between the start page and the end page.
Example: 20-25

[ To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Print *
Pripter: v Propedies Aghvanced s Help (3
Copies: |1 [C1Prnt in grayszale (black and white)

[ 5ave inkftener (L
Pages b Print Comments B Faras
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Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

g Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

w» Related Information

Links to related sections.

Descriptions Used in this Manual

[d Screenshots of the printer driver screens are from Windows 10 or macOS Sierra. The content displayed on the
screens varies depending on the model and situation.

[ Tllustrations of the printer used in this manual are examples only. Although there may be slight differences
depending on the model, the method of operation is the same.

(d Some of the menu items on the LCD screen vary depending on the model and settings.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista",
"Windows XP", "Windows Server 2016", "Windows Server 2012 R2", "Windows Server 2012", "Windows Server 2008
R2", "Windows Server 2008", "Windows Server 2003 R2", and "Windows Server 2003" refer to the following
operating systems. Additionally, "Windows" is used to refer to all versions.

d Microsoft® Windows® 10 operating system

(d Microsoft® Windows® 8.1 operating system

[d Microsoft® Windows® 8 operating system

([ Microsoft® Windows® 7 operating system

[ Microsoft® Windows Vista® operating system

[ Microsoft® Windows® XP operating system

(J Microsoft® Windows® XP Professional x64 Edition operating system
[d Microsoft® Windows Server® 2016 operating system

[J Microsoft® Windows Server® 2012 R2 operating system

J Microsoft® Windows Server® 2012 operating system
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(d Microsoft® Windows Server® 2008 R2 operating system
[ Microsoft® Windows Server® 2008 operating system
[J Microsoft® Windows Server® 2003 R2 operating system

d Microsoft® Windows Server® 2003 operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS Sierra, OS X El Capitan, OS X Yosemite, OS X Mavericks, OS X
Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

[d Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.

http://support.epson.net/symbols

(4 Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

(d Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, or options by yourself, except
as specifically explained in the printer's manuals.

(J Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

[ Place the printer near a wall outlet where the plug can be easily unplugged.

(A Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

(d Take care not to spill liquid on the printer and not to handle the printer with wet hands.

(d Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

[ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

[d The printer is heavy and should not be lifted or carried by less than two people. When lifting the printer, two or
more people should assume the correct positions as shown below.
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[d Be careful when you handle used ink supply units, as there may be some ink around the ink supply port.
[ If ink gets on your skin, wash the area thoroughly with soap and water.

[ If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

[ If ink gets into your mouth, see a doctor right away.

(d Do not disassemble the ink supply unit and the maintenance box; otherwise ink may get into your eyes or on
your skin.

(d Do not shake ink supply units too vigorously; otherwise ink may leak from the ink supply units.

[J Keep ink supply units and maintenance box out of the reach of children.

Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up the Printer

(4 Do not block or cover the vents and openings in the printer.

[d Use only the type of power source indicated on the printer's label.

[d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
(4 Avoid electrical outlets controlled by wall switches or automatic timers.

[d Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

[d The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

[ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

(d When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

[J Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

[d Allow space above the printer so that you can fully raise the printer cover.
[d Leave enough space in front of the printer for the paper to be fully ejected.

[d Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

10
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Advisories and Warnings for Using the Printer

[d Do not insert objects through the slots in the printer.

(d Do not put your hand inside the printer during printing.

(d Do not touch the white flat cable inside the printer.

(d Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.

(d Do not move the print head by hand; otherwise, you may damage the printer.

(d Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet
until the O light stops flashing.

[ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

Advisories and Warnings for Transporting or Storing the Printer
[ When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

[d Before transporting the printer, make sure that the print head is in the home (far right) position, and the ink
supply units are installed.

Advisories and Warnings for Using the Printer with a Wireless

Connection

[J Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing
them to malfunction. When using this printer inside medical facilities or near medical equipment, follow

directions from the authorized personnel representing the medical facilities, and follow all posted warnings and
directions on the medical equipment.

[J Radio waves from this printer may negatively aftect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Advisories and Warnings for Using the LCD Screen

[J The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

(J Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.

[d The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the
screen's surface chips or cracks, and do not touch or attempt to remove the broken pieces.

Protecting Your Personal Information

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's
memory by selecting the menus on the control panel as described below.

1
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Settings > General Settings > System Administration > Restore Default Settings > All Settings

12
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Printer Basics

Part Names and Functions

(1) Control panel

Operates the printer.

You can change the angle of the control panel.

(2] Paper cassette 1 or Paper cassette (C1)

Loads paper.

(3) Paper cassette 2 (C2)

Optional paper cassette unit.

Loads paper.

13
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(
\_
(1] Edge guides Feeds the paper straight into the printer. Slide to the edges of the
paper.
(2] Paper support Supports loaded paper.
(3] Feeder guard Prevents foreign substance from entering the printer. Usually keep
this guard closed.
(4] Rear paper feed (B) Loads paper.
(5] Output tray Holds the ejected paper.
(6] Edge guides Feeds the paper straight into the printer. Slide to the edges of the
paper.
(7] Paper cassette Loads paper.

14
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(1) Printer cover (J) Open when removing jammed paper inside the printer.
(2] Print head Fires ink.

(3) Ink supply unit tray Sets an ink supply unit.

(4] Front cover (A) Open when replacing ink supply units.

(5] Front cover lock Locks the front cover.

I,
0O
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(1) LAN port Connects a LAN cable.
(2] USB port Connects a USB cable.
(3) Service USB port USB port for future use.
Do not remove the sticker.
(4] ACinlet Connects the power cord.
(5] Rear Cover (D) Open when removing jammed paper.
(6) Rear Cover (E) Open when removing jammed paper.
(7) Maintenance box cover (H) Open when replacing the maintenance box.

Control Panel

o © ©

(4
I

(5]
I

Z o

o

i
Error qu Data
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@
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© |
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L

)

"1
(10] 9

I
18]

© O

e

Pass a smart device over this mark to print from the smart device directly.

®

Turns the printer on or off.

Unplug the power cord when the power light is off.

Displays the home screen.

Displays the Paper Setting screen. You can select the paper size and paper type settings for each paper source.

Stops the current operation.

Applies to a variety of functions depending on the situation.

Press 4, A, P> and ¥ to select the items. Press OK to confirm your selection or run the selected feature.

Returns to the previous screen.

® 06 © 0|6 6 o0

Flashes when the printer is processing data.

It turns on when there are queued jobs.

e

Flashes or turns on when an error occurs.
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Basic Screen Configuration

o_' o n O G ©) Maintenance

Print Quality o

. ) &A Adjustment
+
@ Print Head Nozzle

Print Head Cleaning (@)

Maintenance  Settings Wi-Fi )
Information @ e
(1) Indicates items that have been setup for the printer as icons. Select the icon to check the current settings or access

each setting menu.

This action bar is displayed on the home screen only.

(2] Displays each mode.

(3] Available buttons are displayed.

Icons displayed in the LCD Screen

The following icons are displayed on the LCD screen depending on the printer's status.

O

Displays the Supply Status screen.

You can check the approximate ink levels and the approximate service life of the maintenance box.

wIE

Indicates the network connection status.
Select the icon to check and change the current settings. This is the shortcut for the following menu.

Settings > General Settings > Network Settings > Wi-Fi Setup

The printer is not connected to a wired (Ethernet) network or unset it.

The printer is connected to a wired (Ethernet) network.

The printer is not connected to a wireless (Wi-Fi) network.

The printer is searching for SSID, unset IP address, or having a problem with a wireless (Wi-Fi)
network.

The printer is connected to a wireless (Wi-Fi) network.

IEIRIEIES

The number of bars indicates the signal strength of the connection. The more bars there are, the
stronger the connection.

The printer is not connected to a wireless (Wi-Fi) network in Wi-Fi Direct (Simple AP) mode.

The printer is connected to a wireless (Wi-Fi) network in Wi-Fi Direct (Simple AP) mode.

AR
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Indicates whether or not Quiet Mode is set for the printer. When this feature is enabled, the noise made
by printer operations is reduced, but print speed may slow down. However, noises may not be reduced
depending on the selected paper type and print quality.

B

Displays the Help screen. You can view the operating instructions or the solutions to problems.

Indicates that there is additional information. Select the icon to displays the message.

2 Q0K

Indicates a problem with the items. Select the icon to check how to solve the problem.

Basic Operations

Move the focus using the A 'V 4P buttons to select the items, and then press the OK button to confirm your
selection or run the selected feature.

Maintenance  Settings Wi-Fi . J

Move the focus to the setting item using the A W 4P buttons, and then press the OK button to switch the item
on or off.

Basic Settings
Date/Time Settings @
Language
English

Operation Time Out

On &
Keyboard

NWERTV Q
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To enter the value, name, address, and so on, move the focus to the input field using the A V¥V 4P buttons, and
then press the OK button to display the on-screen keyboard.

Enter Manually

@

Enter Password

Entering Characters

On-screen Keyboard

You can enter characters and symbols by using on-screen keyboard when you make network settings and so on.
|
' 0/32 ' @

”anm
fomn . K|
00 600 0 O 0

Note:
Available icons vary depending on the setting item.

(1) Indicates the character count.
(2] Moves the cursor to the input position.
(3) Switches between upper case and lower case or numbers and symbols.

You can also switch them by using the G button.

(4] Switches the character type. You can enter alphanumerics and symbols.

You can also switch them by using the G button.

®

Changes the keyboard layout.

(6] Enters frequently used email domain addresses or URLs by simply selecting the item.
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(7] Enters a space.

©

Enters character.

(9] Deletes a character to the left.

Viewing Animations

You can view animations of operating instructions such as loading paper or removing jammed paper on the LCD
screen.

2 Select @ on the home screen: Displays the help screen. Select How To and then select the items that you want
to view.

[ Select How To at the bottom of the operation screen: Displays the context-sensitive animation.

Cassette, extend the Cassette.

[
o

(1) Indicates the total number of steps and the current step number.

In the example above, it shows step 2 from 4 steps.

e Press d button to return to the previous step.

)

Indicates your progress through the current step. The animation repeats when the progress bar reaches the end.

o Press P> button to move to the next step.
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Preparing the Printer

Loading Papers

Available Paper and Capacities

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Genuine Epson Paper

Note:
Genuine Epson paper is not available when printing with the Epson universal printer driver.

Media Name Size Loading Capacity (Sheets) 2-Sided Print-
ing
Paper Cassette Paper Cassette Rear Paper
1 2 Feed

Epson Bright A4 200 400 50 Auto, Manual”
White Ink Jet Pa-
per
Epson Ultra Glos- A4,13x18 cm 50 - 20 -
sy Photo Paper (5%7in.), 10x15

cm (4x6in.)
Epson Premium A4,13x18 cm 50 - 20 -
Glossy Photo Pa- (5%x7in.), 16:9
per wide size

(102%x181 mm),

10x15 cm (4x6

in.)
Epson Premium A4,10x15cm 50 - 20 -
Semigloss Photo (4x6in.)
Paper
Epson Photo Pa- A4,13x18 cm 50 - 20 -
per Glossy (5%7in.), 10x15

cm (4%6 in.)
Epson Matte Pa- A4 50 - 20 -
per-Heavyweight
Epson Double-Si- | A4 20 - 20 -
ded Matte Paper
Epson Photo A4 80 - 70 -

Quality Ink Jet
Paper

*

Only use the rear paper feed to print 2-sided print jobs manually. You can load up to 30 sheets for paper with one side

already printed.
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Note:
(A The availability of paper varies by location. For the latest information on paper available in your area, contact Epson
support.

(A When printing on genuine Epson paper at a user defined size, only Standard or Normal print quality settings are
available. Although some printer drivers allow you to select a better print quality, the printouts are printed using
Standard or Normal.

Commercially Available Paper

Note:
Half letter, SP1 (210x270 mm), SP2 (210x149 mm), SP3 (100x170 mm), SP4 (130x182 mm), SP5 (192x132 mm) and 16K
(195x270 mm) sizes are not available when printing with the PostScript printer driver.
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Media Name

Size

Loading Capacity (Sheets or Envelopes)

2-Sided Print-
ing

Paper Cassette Paper Cassette Rear Paper
1 2 Feed
. *3 ) *1%2
Pljlr;rpaper, Copy Lette.‘r ;3"'\4’ Ex Up to the line indicated by the 80 Auto, Manual
pap ecutive 2, B5, A5, | symbol on the edge guide.
Letterhead SP1(210x270
mm), 16K
Recycled paper (195x270 mm)
Color paper
H *1*2
. Legal, 85):13 " Up to the line indicated by the 80 Manual
Preprinted paper Half letter, A6, symbol on the edge guide
High quality B6, SP2 (210x149
plain paper mm)
SP3 (100x170 Up to the line in- - 80 Manual™172
mm), SP4 dicated by the
(130%182 mm), bol
SP5 (192x132 3ymoo
on the edge
mm) .
guide.
User Defined™3 Uptothelinein- | - 80 Manual1*2
(mm) dicated by the
89%127 to symbol
100x148 on the edge
guide.
*3 *1%2
User Defined Up to the line indicated by the 80 Manual
(mm) symbol on the edge guide.
100x148 to
148x210
215.9%297 to
355.6
*3 *1%2
User Defined Up to the line indicated by the 80 Auto, Manual
(mm) symbol on the edge guide.
148x210to
215.9x297
User Defined 3 - - 80 Manual*?
(mm)
64 to 89x127
User Defined™ - - 1 Manual

(mm)

215.9x355.6 to
6000
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Media Name

Size

Loading Capacity (Sheets or Envelopes)

Paper Cassette
1

Paper Cassette
2

Rear Paper
Feed

2-Sided Print-
ing

Thick paper
(91 to 160 g/m?)

Letter'3, A4, Ex-
ecutive™3, B5, A5,
SP1(210%x270
mm), 16K
(195%270 mm)

90

250

30

Auto, Manual**4

Legal, 8.5x13in,
Half letter’3, A6,
B6, SP2 (210%x149
mm)

90

250

30

Manual™1™4

SP3 (100x170
mm), SP4
(130182 mm),
SP5 (192%132
mm)

920

30

Manual™1™

User Defined™
(mm)

89x127 to
100x148

920

30

Manual™1™4

User Defined™3
(mm)

100x148 to
148x210

215.9x297 to
3556

90

250

30

Manual*1™4

User Defined™3
(mm)

148x210 to
215.9x297

90

250

30

Auto, Manual**4

User Defined™3
(mm)

64 to 89x127

30

Manual™

User Defined™
(mm)

215.9x355.6 to
1117.6

Manual
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Media Name

Size

Loading Capacity (Sheets or Envelopes)

Paper Cassette
1

Paper Cassette
2

Rear Paper
Feed

2-Sided Print-
ing

Thick paper
(161 to 256 g/m?)

Legal, 8.5x13in,
Letter'3, A4, Ex-

30

ecutive3, B5, A5,
Half letter"3, A6,
B6, SP1 (210x270
mm), SP2
(210149 mm),
SP3(100x170
mm), SP4
(130x182 mm),
SP5(192x132
mm), 16K
(195%270 mm)

Manual™

User Defined™3 - - 30
(mm)

64x127 to
215.9x355.6

Manual™

User Defined™ - - 1
(mm)

215.9x355.6 to
1117.6

Manual

Envelope Envelope #10, 10 - 10
Envelope DL, En-

velope C6

Envelope C4 - - 1

*1
*2
*3
*4

Only use the rear paper feed to print 2-sided print jobs manually.
You can load up to 30 sheets for paper with one side already printed.
Only printing from computer is available.

You can load up to 5 sheets for paper with one side already printed.

Related Information

= “Part Names and Functions” on page 13

P

4

aper Handling Precautions

Read the instruction sheets supplied with the paper.
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[J Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the
printable side.

»

[ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.

[d Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

[J Make sure you are using long-grain paper. If you are not sure what type of paper you are using, check the paper
packaging or contact the manufacturer to confirm the paper specifications.

Related Information

= “Printer Specifications” on page 120

Loading Paper in the Paper Cassette

Note:
If the optional paper cassette unit is installed, do not pull out two paper cassettes at the same time.
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1. Check that the printer is not operating, and then pull out the paper cassette.

2. Slide the front edge guide to its maximum position, and then slide the side edge guides to adjust to the paper
size you want to use.

4 )

3. Load paper with the printable side facing down, and then slide the front edge guide to the edge of the paper.
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n Important:

Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load

above the line indicated by the symbol inside the edge guide. For thick paper, do not load above the line

v
indicated by the e symbol inside the edge guide.

4. Insert the paper cassette all the way.

5. On the control panel, set the size and type of the paper you loaded in the paper cassette.
Note:

You can also display the paper size and paper type settings screen by pressing the = button on the control panel.

6. Slide out the output tray when loading paper longer than A4 size.

—

Related Information

= “Paper Handling Precautions” on page 25
= “Available Paper and Capacities” on page 21
= “List of Paper Type” on page 32

= “Loading Envelopes and Precautions” on page 30

Loading Paper in the Rear Paper Feed

1. Open the feeder guard and pull out the paper support.
(D QxA LA
Rj/)

7, ¢
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2. Slide the edge guides.

= =

3. Load paper at the center of the rear paper feed with the printable side facing up.

n Important:

d Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line just under the triangle symbol inside the edge guide.

A Load paper short edge first. However, when you have set the long edge as the width of the user defined size,
load paper long edge first.

Pre-punched paper

00000000

000
000000
000000000000
000000000000

.
.
i ' ’ ’
' B 000000000000
Y '
L
' m

-

Note:

You can use pre-punched paper under the following conditions. Automatic 2-sided printing is not available for
prepunched paper.

A Loading capacity: One sheet
(A Available size: A4, B5, A5, A6, Letter, Legal

(A Binding holes: Do not load paper with the binding holes at the top or the bottom.
Adjust the print position of your file to avoid printing over the holes.
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4. Slide the edge guides to the edges of the paper.

= [ 4‘-\

5. On the control panel, set the size and type of the paper you loaded in the rear paper feed.

Note:

You can also display the paper size and paper type settings screen by pressing the s button on the control panel.

6. Slide out the output tray when loading paper longer than A4 size.

=

Note:
Return the remaining paper to its package. If you leave it in the printer, the paper may curl or the print quality may
decline.

Related Information

= “Paper Handling Precautions” on page 25

= “Available Paper and Capacities” on page 21

= “List of Paper Type” on page 32

= “Loading Envelopes and Precautions” on page 30

= “Loading Long Papers” on page 31

Loading Envelopes and Precautions

Load envelopes in the center of the rear paper feed short edge first with the flap facing down, and slide the edge
guides to the edges of the envelopes.

— L
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Load envelopes in the paper cassettewith the flap facing up, and then slide the edge guides to the edges of the
envelopes.

@J\\ )

(d Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

@:&g

[d Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

[ Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

[d Avoid using envelopes that are too thin, as they may curl during printing.

Related Information

= “Available Paper and Capacities” on page 21

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28

Loading Long Papers

Only use the rear paper feed to load long paper. Before loading paper in the printer, cut the paper to the size you
want to print. Select User-Defined as the paper size setting.
[J Make sure the end of the paper is cut perpendicularly. A diagonal cut may cause paper feed problems.

[J Long paper cannot be held in the output tray. Prepare a box and so on to make sure that paper does not fall on
the floor.

(d Do not touch paper that is being fed or ejected. It could injure your hand or cause print quality to decline.
Related Information

= “Available Paper and Capacities” on page 21
= “Loading Paper in the Rear Paper Feed” on page 28
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List of Paper Type

To obtain optimum printing results, select the paper type that suits the paper.

Media Name

Media Type

Control Panel

Printer Driver

PostScript Printer
Driver

Epson Universal Printer
Driver

Epson Bright White Plain paper plain papers Plain Plain
Ink Jet Paper

Epson Ultra Glossy Ultra Glossy Epson Ultra Glossy Epson Ultra Glossy -
Photo Paper

Epson Premium Prem. Glossy Epson Premium Epson Premium -

Glossy Photo Paper

Glossy

Glossy

Epson Premium

Prem. Semigloss

Epson Premium

Epson Premium

Semigloss Photo Semigloss Semigloss
Paper
Epson Photo Paper Glossy Photo Paper Glossy Photo Paper Glossy -

Glossy

Epson Matte Paper- Matte
Heavyweight

Epson Matte Epson Matte -

Epson Photo Quality | Matte
Ink Jet Paper

Epson Matte Photo Quality Ink -

Jet Paper

Thick paper Thick paper1 Thick-Paper1 Thick-Paper1 Thick-Paper1

(91 to 160 g/m?)

Thick paper Thick paper2 Thick-Paper2 Thick-Paper2 Thick-Paper2

(161 to 256 g/m?)

Menu Options for Settings

Select Settings on the home screen of the printer to make various settings.

Menu Options for General Settings

Select the menus on the control panel as described below.

Settings > General Settings
Basic Settings

Select the menus on the control panel as described below.

Settings > General Settings > Basic Settings
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You cannot change settings that have been locked by your administrator.

LCD Brightness:
Adjust the brightness of the LCD screen.

Sleep Timer:

Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not
performed any operations. The LCD screen turns black when the setting time passes.

Power Off Settings:

Your product may have this feature or the Power Off Timer feature depending on the location of
purchase.

(d Power Off If Inactive

Select this setting to turn the printer off automatically if it is not used for a specified period of
time. Any increase will affect the product’s energy efficiency. Please consider the environment
before making any change.

[ Power Off If Disconnected

Select this setting to turn the printer off after 30 minutes when all network ports including the
LINE port are disconnected. This feature may not be available depending on your region.
Power Off Timer:

Your product may have this feature or the Power Off Settings feature depending on the location of
purchase.

Select this setting to turn the printer off automatically when it is not used for a specified period of
time. You can adjust the time before power management is applied. Any increase will affect the
product’s energy efficiency. Please consider the environment before making any change.

Date/Time Settings:
1 Date/Time

Enter the current date and time.

(J Daylight Saving Time

Select the summer time setting that applies to your area.

(d Time Difference

Enter the time difference between your local time and UTC (Coordinated Universal Time).

Language:

Select the language used on the LCD screen.

Operation Time Out:

Select On to return to the initial screen when no operations have been performed for the specified
time. When user restrictions have been applied and no operations are performed for the specified
time, you are logged out and returned to the initial screen.

Keyboard:
Change the layout of the keyboard on the LCD screen.
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Related Information
= “Saving Power” on page 42
= “Entering Characters” on page 19

Printer Settings

Select the menus on the control panel as described below.

Settings > General Settings > Printer Settings

You cannot change settings that have been locked by your administrator.
Paper Source Settings:

Paper Setting:

Select the paper size and paper type you loaded in the paper sources.

Rear Paper Feed Priority:
Select On to give printing priority to paper loaded in the rear paper feed.

A4/Letter Auto Switching:
Select On to feed paper from the paper source set as A4 size when there is no paper source set
as Letter, or feed from the paper source set as Letter size when there is no paper source set as
A4.

Auto Select Settings:
Select On for settings to automatically print on paper from any source containing paper that
matches your paper settings.

Error Notice:
Select On to display an error message when the selected paper size or type does not match the
loaded paper.

Paper Setup Auto Display:
Select On to display the Paper Setting screen when loading paper in the paper source. If you
disable this feature, you cannot print from an iPhone or iPad using AirPrint.

Printing Language:

Select the printing language for the USB interface or the network interface.

Universal Print Settings:

These print settings are applied when you print by an external device without using the printer driver.

Top Offset:
Adjust the top margin of the paper.

Left Offset:
Adjust the left margin of the paper.
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Top Offset in Back:
Adjust the top margin for the back of the page when performing 2-sided printing.

Left Offset in Back:
Adjust the left margin for the back margin of the page when performing 2-sided printing.

Check Paper Width:

Select On to check the paper width before printing. This prevents printing beyond the edges of
the paper when the paper size setting is incorrect, but this may lower the print speed.

Skip Blank Page:
Skips blank pages in the print data automatically.

PDL Print Configuration:
Select the PDL Print Configuration options you want to use for PCL or PostScript printing.

Common Settings:
(A Paper Size
Select the default paper size for PCL or PostScript printing.
[ Paper Type
Select the default paper type for PCL or PostScript printing.
(d Orientation
Select the default orientation for PCL or PostScript printing.
d Quality
Select the print quality for PCL or PostScript printing.
(d Ink Save Mode
Select On to save ink by reducing the print density.
[ Print Order
Last Page on Top:
Starts printing from the first page of a file.
First Page on Top:
Starts printing from the last page of a file.
[d Number of Copies
Set the number of copies to print.
(J Binding Margin
Select the binding position.
(4 Auto Paper Ejection
Select On to eject paper automatically when printing is stopped during a print job.
(d 2-Sided Printing
Select On to perform 2-sided printing.
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PCL Menu:

[d Font Source
Resident
Select to use a font preinstalled on the printer.
Download

Select to use a font you have downloaded.

(d Font Number

Select the default font number for the default font source. The available number
varies depending on the settings you made.

[ Pitch

Set the default font pitch if the font is scalable and of fixed-pitch. You can select from
0.44 t0 99.99 cpi (characters per inch), in 0.01 increments.

This item may not appear depending on the font source or font number settings.

(J Height

Set the default font height if the font is scalable and proportional. You can select from
4.00 to 999.75 points, in 0.25 increments.

This item may not appear depending on the font source or font number settings.

(d Symbol Set

Select the default symbol set. If the font that you selected in the font source and the
font number setting is not available in the new symbol set setting, the font source and
the font number settings are automatically replaced with the default value, IBM-US.

d Form

Set the number of lines for the selected paper size and orientation. This also causes a
line spacing (VMI) change, and the new VMI value is stored in the printer. This
means that later changes in the page size or orientation settings cause changes in the
Form value based on the stored VMI.

[d CR Function

Select the line feed command when printing with a driver from a specific operating
system.

([ LF Function

Select the line feed command when printing with a driver from a specific operating
system.

[d Paper Source Assign

Set the assignment for the paper source select command. When 4 is selected, the
commands are set as compatible with the HP LaserJet 4. When 4K is selected, the
commands are set as compatible with the HP LaserJet 4000, 5000, and 8000. When
5S is selected, the commands are set as compatible with the HP LaserJet 5S.

PS3 Menu:
([ Error Sheet

Select On to print a sheet showing the status when an error occurs during PostScript
or PDF printing.

[ Coloration

Select the color mode for PostScript printing.
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1 Binary

Select On when printing data that contains binary images. The application may send
the binary data even if the printer driver setting is set to ASCII, but you can print the
data when this feature is enabled.

(1 PDF Page Size
Select the paper size when printing a PDF file. If Auto is selected, the paper size is

determined based on the size of the first page.
Auto Error Solver:
Select an action to perform when a 2-sided printing error or a memory full error occurs.

d On

Displays a warning and prints in single-sided mode when a 2-sided printing error occurs, or prints
only what the printer could process when a memory full error occurs.

a off

Displays an error message and cancels printing.

Thick Paper:

Select On to prevent ink from smearing on your printouts, however, this may lower the print speed.

Quiet Mode:
Select On to reduce noise during printing, however, this may lower the print speed. Depending on
the paper type and print quality settings you selected, there may be no difference in the printer's noise
level.

Ink Drying Time:
Select the ink drying time you want to use when performing 2-sided printing. The printer prints the
other side after printing one side. If your printout is smeared, increase the time setting.

PC Connection via USB:
Select Enable to allow a computer to access the printer when connected by USB. When Disable is
selected, printing that is not sent over a network connection is restricted.

USB I/F Timeout Setting:

Specify the length of time in seconds that must elapse before ending USB communication with a
computer after the printer receives a print job from a PostScript printer driver or PCL printer driver.
If the job ending is not clearly defined from a PostScript printer driver or PCL printer driver, it can
cause endless USB communication. When this occurs, the printer ends communication after the
specified time has elapsed. Enter 0 (zero) if you do not want to end communication.

Related Information

= “Loading Papers” on page 21
Network Settings

Select the menus on the control panel as described below.

Settings > General Settings > Network Settings
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You cannot change settings that have been locked by your administrator.

Wi-Fi Setup:

Set up or change wireless network settings. Choose the connection method from the following and then
follow the instructions on the LCD panel.

J Router
[ Wi-Fi Direct

Wired LAN Setup:
Set up or change a network connection that uses a LAN cable and router. When this is being used, Wi-
Fi connections are disabled.
Network Status:
Displays or prints the current network settings.
[ Wired LAN/Wi-Fi Status
[ Wi-Fi Direct Status
(A Print Status Sheet

Connection Check:

Checks the current network connection and prints a report. If there are any problems with the

connection, see the report to solve the problem.
Advanced:

Make the following detailed settings.

(4 Device Name

1 TCP/IP

(d Proxy Server

[ IPv6 Address

1 NFC

[ Link Speed & Duplex

(4 Redirect HTTP to HTTPS

(d Disable IPsec/IP Filtering

(4 Disable IEEE802.1X

Web Service Settings

Select the menus on the control panel as described below.

Settings > General Settings > Web Service Settings

You cannot change settings that have been locked by your administrator.

Epson Connect Services:

Displays whether the printer is registered and connected to Epson Connect.

38



User's Guide

Preparing the Printer

You can register to the service by selecting Register and follow the instructions.
When you have registered, you can change the following settings.

[d Suspend/Resume

[d Unregister

For details, see the following web site.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Google Cloud Print Services:
Displays whether the printer is registered and connected to Google Cloud Print services.
When you have registered, you can change the following settings.
(J Enable/Disable
(1 Unregister

For details on registering to Google Cloud Print services, see the following web site.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

System Administration

Select the menu on the control panel as described below.

Settings > General Settings > System Administration

Administrators use this feature. See the Administrator's Guide for details.

Menu Options for Print Counter

Select the menus on the control panel as described below.

Settings > Print Counter

Displays the total number of prints, B&W prints, and color prints from the time you purchased the printer.

Menu Options for Supply Status

Select the menu on the control panel as described below.

Settings > Supply Status
Displays the approximate level of the ink and service life of the maintenance box.

When the ! mark is displayed, ink is running low or the maintenance box is nearly full. When the X mark is
displayed, you need to replace the item as ink is expended or the maintenance box is full.
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Menu Options for Maintenance

Select the menus on the control panel as described below.

Settings > Maintenance

Print Quality Adjustment:

Select this feature if there are any problems with your print outs. You can check for clogged nozzles
and clean the print head if necessary, and then adjust some parameters to improve print quality.

Print Head Nozzle Check:

Select this feature to check if the print head nozzles are clogged. The printer prints a nozzle check
pattern.

Print Head Cleaning:

Select this feature to clean clogged nozzles in the print head.

Print Head Alignment:
Select this feature to adjust the print head to improve print quality.
(J Ruled Line Alignment
Select this feature to align vertical lines.

(J Horizontal Alignment

Select this feature if horizontal banding appears at regular intervals in your printouts.

Paper Guide Cleaning:

Select this feature if there are ink stains on the internal rollers. The printer feeds paper to clean the
internal rollers.

Periodic Cleaning:

The printer automatically performs Print Head Nozzle Check and Print Head Cleaning based on
the specific period of time. Select On to maintain premium print quality. Under the following
conditions, perform Print Head Nozzle Check and Print Head Cleaning yourself.

(d Printout problems

(J When Off is selected for Periodic Cleaning

(J When printing at high quality, such as photos

(J When the Print Head Cleaning message is displayed on the LCD screen

Related Information

= “Adjusting the Print Quality” on page 110

= “Checking and Cleaning the Print Head” on page 88
= “Aligning the Print Head” on page 89

= “Cleaning the Paper Path for Ink Smears” on page 91

40



User's Guide

Preparing the Printer

Menu Options for Language

Select the menus on the control panel as described below.

Settings > Language

Select the language used on the LCD screen.

Menu Options for Printer Status/Print

Select the menus on the control panel as described below.
Settings > Printer Status/Print
Print Status Sheet:

Configuration Status Sheet:

Print information sheets showing the current printer status and settings.

Supply Status Sheet:

Print information sheets showing the status of consumables.

Usage History Sheet:

Print information sheets showing the usage history of the printer.

PS3 Font List:

Print a list of fonts that are available for a PostScript printer.

PCL Font List:

Print a list of fonts that are available for a PCL printer.

Network:

Displays the current network settings.

Menu Options for Authentication Device Status

Select the menus on the control panel as described below.

Settings > Authentication Device Status

Displays the status of the authentication device.

Menu Options for Epson Open Platform Information

Select the menus on the control panel as described below.

Settings > Epson Open Platform Information
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Displays the status of the Epson Open Platform.

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

Depending on the location of purchase, the printer may have a feature that turns it off automatically if it is not
connected to the network for 30 minutes.

Saving Power - Control Panel

1. Select Settings on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
2. Select General Settings > Basic Settings.

3. Do one of the following.

[ Select Sleep Timer or Power Off Settings > Power Off If Inactive or Power Off If Disconnected, and then
make settings.

[ Select Sleep Timer or Power Off Timer, and then make settings.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.
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Printing from the Printer Driver on Windows

If you cannot change some of the printer driver settings, they may have been restricted by the administrator.
Contact your printer administrator for assistance.

Accessing the Printer Driver

When accessing the printer driver from the computer's control panel, the settings are applied to all of the
applications.

Accessing the printer driver from the control panel

[ Windows 10/Windows Server 2016

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences.

[ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

[ Windows 7/Windows Server 2008 R2

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

[ Windows Vista/Windows Server 2008

Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Select printing preferences.

(d Windows XP/Windows Server 2003 R2/Windows Server 2003

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.

Printing Basics

Note:
Operations may differ depending on the application. See the application’s help for details.
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1. Open the file you want to print.
Load paper in the printer if it has not already been loaded.

2. Select Print or Page Setup from the File menu.
3. Select your printer.

4. Select Preferences or Properties to access the printer driver window.

f= EPSON  XXXXSeries  Printing Preferences X
Main More Options  Maintenance

Printing Presets Paper Source Auto Select ~

Add/Remove Presets... Document Size | A4 210 x 297 mm v

J:: Document - Fast

:' Document - Standard Quality Orientation (®) Portrait () Landscape
5 Document - High Quality

Document - 2-Sided Paper Type Plain paper ~
Document - 2-Up )

Document - 2-Sided with 2-4Jp Quality Standard ~
P
El Document - Fast Grayscale Color @ Color o Grayscale
~& Document - Grayscale

2-Sided Printing | Off ~
Settings... Print Density. ..

jp— @ Multi-Page Off ~ Page Order...
-_I Copies 1 = Collate

Reverze Order

Quiet Mode off -
Show Settings |:| Print Preview
[130b Arranger Lite
Reset Defaults Ink Levels
Gancel ey elp

5. Change the settings as necessary.
See the menu options for the printer driver for details.

Note:
[d You can also see the online help for explanations of the setting items. Right-clinking an item displays Help.

(A When you select Print Preview, you can see a preview of your document before printing.
6. Click OK to close the printer driver window.

7. Click Print.

Note:
When you select Print Preview, a preview window is displayed. To change the settings, click Cancel, and then repeat
the procedure from step 2.

Related Information

= “Available Paper and Capacities” on page 21

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28
= “List of Paper Type” on page 32

= “Main Tab” on page 60
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Printing on 2-Sides

You can print on both sides of the paper. You can also print a booklet that can be created by re-ordering the pages
and folding the printout.

9

7
N

I
|
/I

Note:
1 You can use automatic and manual 2-sided printing. During manual 2-sided printing, flip the paper over to print on the
other side when the printer has finished printing the first side.

1 If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

= “Available Paper and Capacities” on page 21

Print Settings

Manual 2-sided printing is available when EPSON Status Monitor 3 is enabled. However, it may not be available
when the printer is accessed over a network or is used as a shared printer.

Note:
To enable EPSON Status Monitor 3, click Extended Settings on the Maintenance tab, and then select Enable EPSON
Status Monitor 3.

1. On the printer driver's Main tab, select an option from 2-Sided Printing.

2. Click Settings, make the appropriate settings, and then click OK.

Make settings for Print Density if necessary. This setting is not available when you select manual 2-sided
printing.

Note:
(A To print a folded booklet, select Booklet.

[d When setting Print Density, you can adjust print density according to the document type.

(A Printing may be slow depending on the combination of options selected for Select Document Type in the Print
Density Adjustment window and for Quality on the Main tab.
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3. Click Print.

For manual 2-sided printing, when the first side has finished printing, a pop-up window is displayed on the
computer. Follow the on-screen instructions.

Related Information
= “Printing Basics” on page 43
= “Main Tab” on page 60

Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Print Settings

On the printer driver's Main tab, select 2-Up or 4-Up as the Multi-Page setting.
Related Information

= “Printing Basics” on page 43
= “Main Tab” on page 60
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Printing and Stacking in Page Order (Reverse Order Printing)

You can print from the last page so that the documents are stacked in page order.

=

Print Settings

On the printer driver's Main tab, select Reverse Order.

Related Information
= “Printing Basics” on page 43
= “Main Tab” on page 60

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

/|
N

Print Settings

On the printer driver's More Options tab, select the document size from the Document Size setting. Select the
paper size you want to print on from the Output Paper setting. Select Reduce/Enlarge Document, and then select
Fit to Page or Zoom to. When you select Zoom to, enter a percentage.

Select Center to print the images in the center of the page.
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Related Information
= “Printing Basics” on page 43
= “More Options Tab” on page 61

Printing One Image on Multiple Sheets for Enlargement (Creating a
Poster)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping
them together.

—— I =
Print Settings

On the printer driver's Main tab, select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster as the Multi-Page
setting. If you click Settings, you can select the panels that you do not want to print. You can also select the cutting
guide options.

Related Information

= “Printing Basics” on page 43
= “Main Tab” on page 60
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Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.

sheet1I <:> lsheet2

@
—>

sheet 3 sheet 4

1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.

4 )

8 sheet1 ¥ B  sheet2 K B sheet1 ¥ sheet2 K

\ 4
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.

4 )
\__ J
] ﬁ/m
¥ sheet1 sheet2 K
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3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).

4 _ )
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8 sheet1 ! sheet2 ¥ B sheet1 sheet2 K
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4. Tape the sheets together from the back.

= ® =
¥ sheet1 sheet2 K

= X 034

5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.

6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.

4 )

[>:] [ [

¥ sheet1 sheet2 H
4
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7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then

temporarily tape them together from the back.

(

\

Printing

1] ®
¥ sheet1 sheet2 K
s 3 | s > g
sheet 3 sheet 4
El:x ENJE
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).

4 )

& [>:] [15] X
= ¥ sheet1 sheet2 H

sheet2 H

g sheet3 sheet 4 =¥ g sheet3 sheet4 g
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9. Tape the sheets together from the back.

= 1] ®
¥ sheet1 sheet2 K

B sheet 3 i sheet 4 uﬂ

53



User's Guide

Printing

10. Cut off the remaining margins along the outer guide.
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Printing with a Header and Footer

You can print information such as a user name and printing date in headers or footers.

o (m» =

Print Settings

On the printer driver's More Options tab, click Watermark Features, and then select Header/Footer. Click
Settings, and then select the items you want to print.
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Related Information
= “Printing Basics” on page 43
= “More Options Tab” on page 61

Printing a Watermark

You can print a watermark such as "Confidential” or an anti-copy pattern on your printouts. If you print with an
anti-copy pattern, the hidden letters appear when photocopied in order to distinguish the original from the copies.

D__ D__

= |4 Copy mp —

Anti-Copy Pattern is available under the following conditions:

[ Paper: Plain paper, Copy paper, Letterhead, Recycled paper, Colored paper, Preprinted paper, or High quality
plain paper

(J Quality: Standard
[d Automatic 2-sided printing: Not selected

[ Color Correction: Automatic

Note:
You can also add your own watermark or anti-copy pattern.

Print Settings

On the printer driver's More Options tab, click Watermark Features, and then select Anti-Copy Pattern or
Watermark. Click Settings to change details such as the size, density, or position of the pattern or the mark.

Related Information

= “Printing Basics” on page 43
= “More Options Tab” on page 61
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Printing Password-Protected Files

Yon can set a password for a print job so that it starts printing only after entering the password on the printer's
control panel.
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Print Settings

On the printer driver's More Options tab, select Confidential Job, and then enter a password.

To print the job, select Settings on the home screen of the printer's control panel, and then select Confidential Job.
Select the job you want to print, and then enter the password.

Related Information
= “Printing Basics” on page 43
= “More Options Tab” on page 61

Printing Multiple Files Together

Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as multi-page layout, and 2-sided printing.
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Print Settings
On the printer driver's Main tab, select Job Arranger Lite. When you start printing, the Job Arranger Lite window

is displayed. With the Job Arranger Lite window opened, open the file that you want to combine with the current
file, and then repeat the above steps.
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When you select a print job added to Print Project in the Job Arranger Lite window, you can edit the page layout.
Click Print from the File menu to start printing.

Note:
If you close the Job Arranger Lite window before adding all the print data to the Print Project, the print job you are currently
working on is canceled. Click Save from the File menu to save the current job. The extension of the saved files is "ecl”.

To open a Print Project, click Job Arranger Lite on the printer driver's Maintenance tab to open the Job Arranger Lite
window. Next, select Open from the File menu to select the file.

Related Information
= “Printing Basics” on page 43
= “Main Tab” on page 60

Printing Using the Color Universal Print Feature

You can enhance the visibility of texts and images in printouts.
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Color Universal Print is only available when the following settings are selected.

[d Paper Type: Plain paper, Copy paper, Letterhead, Recycled paper, Colored paper, Preprinted paper, High quality
plain paper

(J Quality: Standard or a higher quality

[ Print Color:Color

(d Applications: Microsoft® Office 2007 or later
[ Text Size: 96 pts or smaller

Print Settings
On the printer driver's More Options tab, click Image Options in the Color Correction setting. Select an option
from the Color Universal Print setting. Click Enhancement Options to make further settings.

Note:
[d Certain characters may be altered by patterns, such as "+" appearing as "+".

1 Application-specific patterns and underlines may alter content printed using these settings.
[ Print quality may decrease in photos and other images when using Color Universal Print settings.

[ Printing is slower when using Color Universal Print settings.
Related Information

= “Printing Basics” on page 43
= “More Options Tab” on page 61
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Adjusting the Print Color

You can adjust the colors used in the print job.
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Note:
These adjustments are not applied to the original data.

Print Settings

On the printer driver's More Options tab, select Custom as the Color Correction setting. Click Advanced to open
the Color Correction window, and then select the method of color correction.

Note:
d Automatic is selected as default on the More Options tab. With this setting, the colors are automatically adjusted to
match the paper type and print quality settings.

[d PhotoEnhance on the Color Correction window adjusts the color by analyzing the location of the subject. Therefore, if
you have changed the location of the subject by reducing, enlarging, cropping, or rotating the image, the color may change
unexpectedly. If the image is out of focus, the tone may be unnatural. If the color is changed or becomes unnatural, print
in a mode other than PhotoEnhance.

Related Information
= “Printing Basics” on page 43
= “More Options Tab” on page 61

Printing to Emphasize Thin Lines

You can thicken thin lines that are too thin to print.

=

Print Settings

On the printer driver's More Options tab, click Image Options in the Color Correction setting. Select Emphasize
Thin Lines.

Related Information

= “Printing Basics” on page 43
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= “More Options Tab” on page 61

Printing Clear Bar Codes

You can print a bar code clearly and make it easy to scan. Only enable this feature if the bar code you printed

cannot be scanned.

You can use this feature under the following conditions.

01234

[d Paper: Plain paper, Copy paper, Letterhead, Recycled paper, Colored paper, Preprinted paper, High quality plain
paper, Thick paper with a thickness of 91 to 256g/m?, or Envelope

[ Quality: Standard, High (not available for paper with a thickness of 161 to 256 g/m?®)

Note:
Deblurring may not always be possible depending on the circumstances.

Print Settings

On the printer driver's Maintenance tab, click Extended Settings, and then select Barcode mode.

Related Information
= “Printing Basics” on page 43
= “Maintenance Tab” on page 61

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

On your computer, right-click on your printer in Devices and Printers, Printer, or in Printers and Faxes. Click
See what's printing, right-click on the job you want to cancel, and then select Cancel.

Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.
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Menus vary depending on the option you selected.

Main Tab

Printing Presets

Add/Remove Presets You can add or remove your own presets for frequently used print

settings. Select the preset you want to use from the list.

Show Settings

Displays a list of items currently set on the Main and More Options tabs.

Reset Defaults

Return all settings to their factory default values. The settings on the More Options tab are also
reset to their defaults.

Ink Levels

Displays the approximate ink levels.

Paper Source

Select the paper source from which the paper is fed. Select Auto Select to automatically select the
paper source selected in Paper Setting on the printer.

Document Size

Select the paper size on which you want to print. If you select User-Defined, enter the paper width
and height.

Orientation Select the orientation you want to use to print.

Paper Type Select the type of paper on which you print.

Quality Select the pint quality you want to use for printing. Available settings depend on the paper type
you select.

Color Select the color for your print job.

2-Sided Printing

Allows you to perform 2-sided printing.

Settings You can specify the binding edge and the binding margins. When
printing multi-page documents, you can select to print starting from
either the front or the back side of the page.

Print Density Select the document type to adjust the print density. If the appropriate
print density is selected, you can prevent images from bleeding through

to the reverse side. Select User Defined to adjust the print density

manually.
Multi-Page Allows you to print several pages on one sheet or perform poster printing. Click Page Order to
specify the order in which pages are printed.
Copies Set the number of copies you want to print.
Collate Prints multi-page documents collated in order and sorted into sets.
Reverse Order Allows you to print from the last page so that the pages are stacked in the
correct order after printing.
Quiet Mode Reduces the noise the printer makes. However, enabling this may reduce print speed.

Print Preview

Displays a preview of your document before printing.

Job Arranger Lite

Select to print using the Job Arranger Lite feature.

60




User's Guide

More Options Tab

Printing

Printing Presets

Add/Remove Presets

You can add or remove your own presets for frequently used print
settings. Select the preset you want to use from the list.

Show Settings

Displays a list of items currently set on the Main and More Options tabs.

Reset Defaults

Return all settings to their factory default values. The settings on the Main tab are also reset to their

defaults.

Document Size

Select the size of your document.

Output Paper

Select the paper size on which you want to print. If the Output Paper differs from Document Size,
Reduce/Enlarge Document is selected automatically. You do not have to select Output Paper
when printing documents without changing the size.

Reduce/Enlarge

Allows you to reduce or enlarge the size of a document.

Document
Fit to Page Automatically reduce or enlarge the document to fit to the paper size
selected in Output Paper.
Zoom to Prints with a specific percentage.
Center Prints images in the center of the paper.
Color Correction Automatic Adjusts the colors of images automatically.
Custom Allows you to perform manual color correction. Click Advanced for

further settings.

Image Options

Enables print quality options such as Color Universal Print or Fix Red-
Eye. You can also thicken thin lines to make them visible on the
printouts.

Watermark Features

Allows you to make settings for anti-copy patterns or watermarks.

Confidential Job

Password-protect confidential documents when printing. If you use this feature, the print data is
stored in the printer and can only be printed after the password has been entered using the
printer's control panel. Click Settings to change the settings.

Additional Settings

Rotate 180°

Rotates pages 180 degrees before printing. This feature is helpful when
printing on paper such as envelopes that are loaded in fixed direction in
the printer.

High Speed Prints when the print head moves in both directions. The print speed is
faster, but the quality may decline.
Mirror Image Inverts the image so that it prints as it would appear in a mirror.
Maintenance Tab

Nozzle Check

Prints a nozzle check pattern to check if the print head nozzles are clogged.

Head Cleaning

Cleans the clogged nozzles in the print head. Because this feature uses some ink, clean the print
head only if the nozzles are clogged.

Job Arranger Lite Opens the Job Arranger Lite window. You can save and edit data.
EPSON Status Opens the EPSON Status Monitor 3 window. Here you can confirm the status of the printer and the
Monitor 3 consumables.
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Monitoring Allows you to make settings for items on the EPSON Status Monitor 3 window.
Preferences
Extended Settings Allows you to make a variety of settings. Right-click each item to view the Help for more details.
Print Queue Displays the jobs waiting to be printed. You can check, pause, or resume print jobs.
Printer and Option You can register user accounts. If access control is set on the printer, you must register your
Information account.
Language Changes the language to be used on the printer driver window. To apply the settings, close the

printer driver, and then open it again.
Software Update Starts EPSON Software Updater to check for the latest version of applications on the Internet.
Technical Support Allows you to access the Epson technical support website.

Printing from the PostScript Printer Driver on
Windows

A PostScript Printer Driver is a driver that outputs printing commands to a printer using a PostScript Page
Description Language.

1. Open the file you want to print.
Load paper in the printer if it has not already been loaded.

2. Select Print or Print Setup from the File menu
3. Select your printer.

4. Select Preferences or Properties to access the printer driver window.

= EPSON XXXX Series Printing Preferences x
Faper/Guslity  |ayout  Access Cortrol Settings

Tray Selection

Paper Source: Automatically Select ~
Media: ‘ Plain v‘

Color

() Blagk & White @ Color

Adyvanced...

Sancel oy

62



User's Guide

5. Change the settings as necessary.

Printing

See the menu options for the printer driver for details.

6. Click OK to close the printer driver for details.

7. Click Print.

Related Information

= “Available Paper and Capacities” on page 21

= “Loading Paper in the Paper Cassette” on page 26

= “Loading Paper in the Rear Paper Feed” on page 28

= “List of Paper Type” on page 32

= “Paper/Quality Tab” on page 63

= “Layout Tab” on page 63

Menu Options for the PostScript Printer Driver

Open the print window on an application, select the printer, and then access the printer driver window.

Note:

Menus vary depending on the option you selected.

Paper/Quality Tab

Tray Selection

Paper Source

Select the paper source from which the paper is fed.

Select Automatically Select to automatically select the paper
source selected in the Paper Setting on the printer.

Media

Select the type of paper on which you print.

Color Select the color for your print job.
Layout Tab
Orientation Select the orientation you want to use to print.

Print on Both
Sides

Allows you to perform 2-sided printing.

Page Order

Select to print from the top or the last page. If you select Back to Front, the pages are stacked in the
correct order based on page number after printing.

Page Format

Pages per Sheet

Allows you to print several pages on one sheet.

Pages per Sheet
Layout

Allows you to specify the page layout when printing several
pages on one sheet.

Booklet

Select to create a booklet.

Booklet Binding

Select the binding position for booklet.
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Access Control Settings Tab

Printer usage may have been restricted by the administrator. Printing is available after registering your account to
the printer driver. Contact the administrator for details on your user account.

Access Control Settings User Registration Allows you to enter a user name and password.
User Name Enter a user name.
Password Enter a password.
Advanced Options
Paper/Output Paper Size Select the paper size on which you want to print.
Copies Set the number of copies you want to print.
Graphic Print Quality Select the pint quality you want to use for printing.
Image Color Select the ICM method or intent.
Management
Scaling Allows you to reduce or enlarge the document.
TrueType Font Sets the font substitute to TrueType Font.
Document Options Advanced Printing Allows you to make detailed settings for printing features.
Features
PostScript Options Allows you to make optional settings.
Printer Features Color Mode Select whether to print in color or in
monochrome.

Press Simulation You can select a CMYK ink color to simulate
when you print by reproducing the CMYK ink
color of the offset press.

Ink Save Mode Conserves ink by reducing the print density.

Rotate by 180° Rotates the data 180 degrees before printing.

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

On your computer, right-click on your printer in Devices and Printers, Printer, or in Printers and Faxes. Click
See what's printing, right-click on the job you want to cancel, and then select Cancel.
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Printing from the Printer Driver on Mac OS

Printing Basics

Note:
Operations differ depending on the application. See the application’s help for details.

1. Open the file you want to print.
Load paper in the printer if it has not already been loaded.

2. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or¥ to expand the print window.
3. Select your printer.

4. Select Print Settings from the pop-up menu.

Printar:  EPSOMN XXX

Presets: Default Settings

<2 ff <2

Copies: |1

Pages: D All
From: 1 tor 1

Paper Size: A4 B 2106y 267 mm

Orientation: Tf' To

Print Settings E

Paper Source:  Auto Select

Media Type: plain papers

(o} o f o

Print Quality:  Mormal

Grayscale

Mirror Image

Cancel

Note:
On OS X Mountain Lion or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. See the following to add a printer.

http://epson.sn
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5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click Print.

Related Information

= “Available Paper and Capacities” on page 21

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28
= “List of Paper Type” on page 32

= “Menu Options for Print Settings” on page 70

Printing on 2-Sides

You can print on both sides of the paper.

9

7
N

I
—
/I

Note:

3 If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

= “Available Paper and Capacities” on page 21

Print Settings

Select Two-sided Printing Settings from the pop-up menu. Select the method of 2-sided printing, and then make

the Document Type settings.

Note:
(A Printing speed may be reduced depending on the document type.

[d When printing photos with dense data, select Text & Graphics or Text & Photos in the Document Type setting. If the
printouts are smeared or ink bleeds through to the other side of the paper, adjust the Print Density and Increased Ink

Drying Time in Adjustments.
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Related Information
= “Printing Basics” on page 65
= “Menu Options for Two-sided Printing Settings” on page 71

Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Print Settings

Select Layout from the pop-up menu. Set the number of pages in Pages per Sheet, the Layout Direction (page
order), and Border.

Related Information
= “Printing Basics” on page 65
= “Menu Options for Layout” on page 70

Printing and Stacking in Page Order (Reverse Order Printing)

You can print from the last page so that the documents are stacked in page order.

=
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Print Settings

Select Paper Handling from the pop-up menu. Select Reverse as the Page Order setting.

Related Information
= “Printing Basics” on page 65
= “Menu Options for Paper Handling” on page 70

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

I

7 |
N

Print Settings

When printing to fit to the paper size, select Paper Handling from the pop-up menu, and then select Scale to fit
paper size. Select the paper size you loaded in the printer in Destination Paper Size. When reducing the size of
the document, select Scale down only.

When printing at a specific percentage, do one of the following.

[ Select Print from the File menu of the application. Select Printer, enter a percentage in Scale, and then click
Print.

[d Select Page Setup from the File menu of the application. Select your printer in Format For, enter a percentage
in Scale, and then click OK.

Note:

Select the paper size you set in the application as the Paper Size setting.

Related Information
= “Printing Basics” on page 65
= “Menu Options for Paper Handling” on page 70
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Adjusting the Print Color

You can adjust the colors used in the print job.

adll

[
[ =

Note:
These adjustments are not applied to the original data.

Print Settings

Select Color Matching from the pop-up menu, and then select EPSON Color Controls. Select Color Options
from the pop-up menu, and then select one of the available options. Click the arrow next to Advanced Settings,
and then make more detailed settings.

Related Information

= “Printing Basics” on page 65

= “Menu Options for Color Matching” on page 70
= “Menu Options for Color Options” on page 71

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

Click the printer icon in the Dock. Select the job you want to cancel, and then do one of the following.

[ OS X Mountain Lion or later

Click next to the progress meter.

[ Mac OS X v10.6.8 to v10.7.x
Click Delete.

Menu Options for the Printer Driver

Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.
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Menu Options for Layout

Pages per Sheet

Select the number of pages to be printed on one sheet.

Layout Direction

Specify the order in which the pages will be printed.

Border

Prints a border around the pages.

Reverse page
orientation

Rotates pages 180 degrees before printing. Select this item when printing on paper such as
envelopes that are loaded in fixed direction in the printer.

Flip horizontally

Inverts an image to print as it would appear in a mirror.

Menu Options for Color Matching

ColorSync

EPSON Color Controls

Select the method for color adjustment. These options adjusts colors between the printer and the
computer display to minimize the difference in color.

Menu Options for Paper Handling

Collate pages

Prints multi-page documents collated in order and sorted into sets.

Pages to Print

Select to print only odd pages or even pages.

Page Order

Select to print from the top or the last page.

Scale to fit paper size

Prints to fit to the paper size you loaded.

Destination Paper
Size

Select the paper size to print on.

Scale down only Select when reducing the size of the document.

Menu Options for Cover Page

Print Cover Page

Select whether or not to print a cover page. When you want to add a back cover, select After
document.

Cover Page Type

Select the contents of the cover page.

Menu Options for Print Settings

Paper Source

Select the paper source from which the paper is fed. If the printer has only one paper source, this
item is not displayed. Selecting Auto Select selects the paper source that matches the Paper
Setting on the printer automatically.

Media Type

Select the type of paper on which you print.

Print Quality

Select the pint quality you want to use for printing. The options vary depending on the paper type.
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Grayscale Select when you want to print in black or shades of gray.
Mirror Image Inverts an image to print as it would appear in a mirror.
Menu Options for Color Options
Manual Settings Adjusts the color manually. In Advanced Settings, you can select detailed settings.
PhotoEnhance Produces sharper images and more vivid colors by automatically adjusting the contrast, saturation,

and brightness of the original image data.

Off (No Color Print without enhancing or adjusting the color in any way.
Adjustment)

Menu Options for Two-sided Printing Settings

Two-sided Printing Prints on both sides of the paper.

Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS Printer Driver

[ Thick paper and envelopes: Prevents the ink from smearing when printing on thick paper. However, this may
reduce print speed.

[ Skip Blank Page: Avoids printing blank pages.

4 Quiet Mode: Reduces the noise the printer makes, however, may reduce print speed.

[J Permit temporary black printing: Prints only with black ink temporarily.

[J High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

(4 Output documents for filing: Feed the paper so that it is easy to file when printing landscape data or 2-sided
printing. Envelope printing is not supported.

[J Warning Notifications: Allows the printer driver to display warning notifications.

(d Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.

[d Lower Cassette: Add the optional paper cassette units to the paper source.
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Printing from the PostScript Printer Driver on Mac OS

A PostScript Printer Driver is a driver that outputs printing commands to a printer using a PostScript Page
Description Language.

1. Open the file you want to print.
Load paper in the printer if it has not already been loaded.

2. Select Print or Print Setup from the File menu.

If necessary, click Show Details or ¥ to expand the print window.
3. Select your printer.

4. Select Print Features from the pop-up menu.

Printer:  EPSON XXXX w
Presets: Default Settings T
Copies: 1 Two-Sided
Pages: © All
From: 1 to: |1
Paper Size: A4 ﬂ 210 by 297 mm

Orientation: | I # I

Printer Features

[Feature Sets:  Quality ﬁ]

MediaType: Plain

Print Quality: Fine ﬁ

Cancel - Print |

5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click Print.

Related Information

= “Available Paper and Capacities” on page 21

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28
= “List of Paper Type” on page 32

= “Menu Options for Printer Features” on page 74
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Menu Options for the PostScript Printer Driver

Open the print window on an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Menu Options for Layout

Pages per Sheet Select the number of pages to be printed on one sheet.

Layout Direction Specify the order in which the pages will be printed.

Border Prints a border around the pages.

Two-Sided Allows you to perform 2-sided printing.

Reverse page Rotates pages 180 degrees before printing.

orientation

Flip horizontally Inverts the image so that it prints as it would appear in a mirror.

Menu Options for Color Matching

ColorSync Select the method for color adjustment. These options adjusts color between the printer and the
computer display to minimize the difference in color.

In Printer

Menu Options for Paper Handling

Collate pages Prints multi-page documents collated in order and sorted into sets.
Pages to Print Select to print only odd pages or even pages.
Page Order Select to print from the top or the last page.

Scale to fit paper size Prints to fit to the paper size you loaded.

Destination Paper Select the paper size to print on.
Size
Scale down only Select when reducing the size of the document.

Menu Options for Paper Feed

All Pages From Select the paper source from which the paper is fed.

Selecting Auto Select selects the paper source that matches the Paper Setting on the printer

First Page From/ ?
automatically.

Remaining From
You can also select the paper source for page.
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Menu Options for Cover Page
Print Cover Page Select whether or not to print a cover page. When you want to add a back cover, select After
document.
Cover Page Type Select the contents of the cover page.
Menu Options for Printer Features
Feature Sets Quality MediaType Select the type of paper on which you print.
Print Quality Select the pint quality you want to use for printing.
Color Color Mode Select whether to print in color or in monochrome.
Press Simulation You can select a CMYK ink color to simulate when
you print by reproducing the CMYK ink color of the
offset press.
Others Ink Save Mode Conserves ink by reducing the print density.

Canceling Printing

You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

Click the printer icon in the Dock. Select the job you want to cancel, and then do one of the following.

[ OS X Mountain Lion or later

Click next to the progress meter.

[ Mac OS X v10.6.8 to v10.7.x
Click Delete.

Printing from Smart Devices

Using Epson iPrint

Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such
as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same
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wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote
print, register your printer in the Epson Connect service.

[ =
-E-

EPSON

Related Information

= “Printing Using a Network Service” on page 100

Connecting from Smart Device by Wi-Fi Direct

You need to connect the smart device to the printer to print from the smart device.

Wi-Fi Direct allows you to connect the printer directly to devices without an access point. The printer acts as an
access point.

g Important:

When you connect from a smart device to the printer using the Wi-Fi Direct (Simple AP) connection, the printer is
connected to the same Wi-Fi network (SSID) as the smart device and the communication is established between
them. Since the smart device is automatically connected to the other connectable Wi-Fi network if the printer is
turned off, it is not connected to the previous Wi-Fi network again if the printer is turned on. Connect to the
printer's SSID for Wi-Fi Direct (Simple AP) connection from the smart device again.

1. Select ﬂg’ | EB on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.

© O =

Confidential
400

Maintenance Seftings

o

2. Select Wi-Fi Direct.

3. Press the OK button.

If you have made Wi-Fi Direct (Simple AP) settings, the detailed connection information is displayed. Go to
step 5.
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4. Press the OK button.

5. Check the SSID and password displayed on the printer's control panel. On the smart device's Wi-Fi screen,
select the SSID shown on the printer's control panel to connect.

Note:
You can check the connection method on the Web site. To access the Web site, scan the QR code displayed on the
printer’s control panel using the smart device , and then go to Setup.

6. Enter the password displayed on the printer's control panel on the smart device.

7. After the connection is established, select OK or Close on the printer's control panel.

8. Close the screen.

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/c

Printing Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice. The contents may vary depending on the product.

(1] 2]

seese 7 19:41 2% [ L L] & 19:41 2% -

Epson iPrint @ £ Home Photos e

35x5in/89x 127 mm

Capture

Memery Ga)

Creative Print | More Apps

Deselect Rotate 0
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(1) Home screen displayed when the application is started.

(2] Displays information on how to setup the printer and a FAQ.

(3] Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

(4] Select what you want to print such as photos and documents.

(5] Displays the screen to make print settings such as paper size and paper type.

(6] Displays photos and documents you selected.

(7] Starts printing.

Note:
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.

Printing by Touching Smart Devices to the N-Mark

You can simply connect and print by touching your smart device to the printer's N-Mark.
Make sure that you prepare the following before using this feature.
[d Enable the NFC function on your smart device.

Only Android 4.0 or later supports NFC (Near Field Communication).

The location and NFC functions vary depending on the smart device. See the documentation provided with
your smart device for details.

[ Install Epson iPrint on your smart device.

Touch your smart device to the printer's N-Mark to install it.

(d Enable Wi-Fi Direct on your printer.

See the Administrator’'s Guide for details.
1. Load paper in the printer.

2. Touch your smart device to the printer's N-Mark.

Epson iPrint starts.
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Note:
(A The printer may not be able to communicate with the smart device when there are obstacles such as metal between
the printer's N-Mark and the smart device.

A Administrators may block this feature. In this case, smart devices only make a sound and do not start any
applications even if you touch them to the printer's N-Mark.

3. Select the file you want to print in Epson iPrint.

4. On the preview screen with the Print icon, touch the smart device to the printer's N-Mark.

Printing starts.

Related Information
= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28

Using Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet
(Android v4.4 or later). With a few taps, your Android device will discover an Epson printer that is connected to
the same wireless network.

1. Load paper in the printer.

2. Set up your printer for wireless printing.

3. On your Android device, install the Epson Print Enabler plug-in from Google Play.

4. Connect your Android device to the same wireless network as your printer.

5. Go to Settings on your Android device, select Printing, and then enable Epson Print Enabler.

6. From an Android application such as Chrome, tap the menu icon and print whatever is on the screen.

Note:
If you do not see your printer, tap All Printers and select your printer.

Related Information
= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28
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Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and
Mac with the latest version of OS X or macOS.

AirPrint

Note:
If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to
enable the messages, if necessary.

1. Load paper in your product.

2. Set up your product for wireless printing. See the link below.

http://epson.sn
3. Connect your Apple device to the same wireless network that your product is using.

4. Print from your device to your product.

Note:
For details, see the AirPrint page on the Apple website.

Related Information
= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28

Canceling Ongoing Jobs

Press the @ button to cancel the ongoing job.
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Replacing Ink Supply Units and Other
Consumables

Checking the Status of the Remaining Ink and the
Maintenance Box

You can check the approximate ink levels and the approximate service life of the maintenance box from the control
panel or the computer.

Checking the Status of the Remaining Ink and the Maintenance Box
- Control Panel

1. Select Settings on the home screen.

2. Select Supply Status.

Note:
The indicator on the far right indicates the available space in the maintenance box.

Checking the Status of the Remaining Ink and the Maintenance Box
- Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab, and then click Details.

Note:
If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Checking the Status of the Remaining Ink and the Maintenance Box
- Mac OS

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.
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Ink Supply Unit Codes

Epson recommends the use of genuine Epson ink supply units. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may

not be displayed.

The following are the codes for genuine Epson ink supply units.

Note:

(A Ink supply unit codes may vary by location. For the correct codes in your area, contact Epson support.

(A Not all ink supply units are available in all regions.

For Europe
Size Black Cyan Magenta Yellow
XXL T9461 - - -
XL T9451 T9452 T9453 T9454
L T9441 T9442 T9443 T9444
Visit the following website for information on Epson's ink supply unit yields.
http://www.epson.eu/pageyield
For Australia and New Zealand
Black Cyan Magenta Yellow
902XXL 902XL 902XL 902XL
902XL 902 902 902
902
For Asia
Black Cyan Magenta Yellow
T9501 T9492 T9493 T9494
T9491 T9482 T9483 T9484
T9481

Ink Supply Unit Handling Precautions

Read the following instructions and Important Safety Instructions (paper manual) before replacing ink supply units.

Handling precautions

[ Store ink supply units at normal room temperature and keep them away from direct sunlight.
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(d Epson recommends using the ink supply unit before the date printed on the package.
[ For best results, store ink supply unit packages with their bottom down.

[J After bringing an ink supply unit inside from a cold storage site, allow it to warm up at room temperature for at
least 12 hours before using it.

d Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

W

[ Install all ink supply units; otherwise you cannot print.
(d Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

[ Do not leave the printer with the ink supply units removed; otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

[ If you need to remove an ink supply unit temporarily, make sure you protect the ink supply area from dirt and
dust. Store the ink supply unit in the same environment as the printer. Because the ink supply port is equipped
with a valve designed to contain the release of excess ink, there is no need to supply your own covers or plugs.

[d Removed ink supply units may have ink around the ink supply port, so be careful not to get any ink on the
surrounding area when removing the ink supply units.

[ This printer uses ink supply units equipped with a green chip that monitors information such as the amount of
remaining ink for each ink supply unit. This means that even if the ink supply unit is removed from the printer
before it is expended, you can still use the ink supply unit after reinserting it back into the printer.

(d To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the ink supply unit when your printer indicates to replace the ink supply unit. The yields quoted for
you do not include this reserve.

(d Although the ink supply units may contain recycled materials, this does not affect printer function or
performance.

[ Specifications and appearance of the ink supply unit are subject to change without prior notice for
improvement.

[d Do not disassemble or remodel the ink supply unit, otherwise you may not be able to print normally.
(d Do not drop or knock the ink supply unit against hard objects; otherwise, the ink may leak.
[J You cannot use the ink supply units that came with the printer for the replacement.

d Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Consumption of Ink

(d To maintain optimum print head performance, some ink is consumed from all ink supply units during
maintenance operations such as print head cleaning. Ink may also be consumed when you turn on the printer.
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[d When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the
paper type or print quality settings. This is because a mixture of color inks is used to create black.

[ The ink in the ink supply units supplied with your printer is partly used during initial setup. In order to produce
high quality printouts, the print head in your printer will be fully charged with ink. This one-off process
consumes a quantity of ink and therefore these ink supply units may print fewer pages compared to subsequent
ink supply units.

[d For best results, use up ink supply unit within two years of installation.

Replacing Ink Supply Units

When a message is displayed prompting you to replace the ink supply units, select How To and then view the
animations displayed on the control panel to learn how to replace the ink supply units.

Related Information

= “Ink Supply Unit Handling Precautions” on page 81

Maintenance Box Code

Epson recommends the use of a genuine Epson maintenance box.
The following is the code for the genuine Epson maintenance box.

T6716

Maintenance Box Handling Precautions

Read the following instructions and Important Safety Instructions (paper manual) before replacing the
maintenance box.

[d Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and
printing.

(4 Do not tilt the used maintenance box until after it is sealed in the plastic bag; otherwise ink may leak.
(d Keep the maintenance box out of direct sunlight.
(d Do not replace the maintenance box during printing; otherwise, ink may leak.

(d Do not reuse a maintenance box which has been removed and left detached for a long period. Ink inside the box
will have solidified and no more ink can be absorbed.

Replacing a Maintenance Box

In some print cycles a very small amount of surplus ink may be collected in the maintenance box. To prevent ink
leakage from the maintenance box, the printer is designed to stop printing when the absorbing capacity of the
maintenance box has reached its limit. Whether and how often this is required will vary according to the number
of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs.
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When a message is displayed prompting you to replace the maintenance box, refer to the animations displayed on
the control panel. The need for replacement of the box does not mean that your printer has ceased to operate in
accordance with its specifications. The Epson warranty does not cover the cost of this replacement. It is a user-
serviceable part.

Note:
When it is full, you cannot print until the maintenance box is replaced to avoid ink leakage.

Related Information

= “Maintenance Box Handling Precautions” on page 83

Temporarily Printing with Black Ink

When color ink is expended and black ink still remains, you can use the following settings to continue printing for
a short time using only black ink.

(4 Type of paper: plain papers, Envelope
(4 Color: Grayscale
[ EPSON Status Monitor 3: Enabled (for Windows only)

Because this feature is only available for approximately five days, replace the expended ink supply unit as soon as
possible.

Note:
(4 If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and
then select Enable EPSON Status Monitor 3.

[d The available period varies depending on the usage conditions.

Temporarily Printing with Black Ink - Control Panel

1. When a message is displayed prompting you to replace the ink supply units, press the OK button.
A message is displayed telling you that you can temporarily print with black ink.

2. Check the message, and then press the OK button.

3. If you want to print in monochrome, select No, cancel printing.

The ongoing job is canceled, and you can print on plain paper with margins around the edges.
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Temporarily Printing with Black Ink - Windows

1. When the following window is displayed, cancel printing.

EPSOM Status Monitor 31 EPSON X0000( Series

Color ink supply unit{s) need to be replaced. Black printing is temporarily available.

Epson recommends the genuine Epsaon ink supply units listed abaove.
To replace them, follow the instructions on the printer's LCD screen.

¥ou can cancel the job and tempararily continue printing in black ink with the following settings:
- Paper Type: Plain paper ar Envelope
- Color: Grayscale

If you cannot print, you may need to cancel the previous print job from the LCD screen and try
agair.

E Close i

EPSOM Status Monitor 3

Black printing is temporarily available using the following settings:
- Paper Type: Plain paper or Envelope

- Color: Grayscale

To continue printing dick [Print in Black].

You can tempararily continue printing. Please replace the expended ink supply unit(s).

Print in Black E Cancel Print i

Note:
If you cannot cancel printing from the computer, cancel using the printer's control panel.

2. Access the printer driver window.

3. Select plain papers or Envelope as the Paper Type setting on the Main tab.

4. Select Grayscale.

5. Set the other items on the Main and More Options tabs as necessary, and then click OK.

6. Click Print.
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Click Print in Black in the window displayed.

Temporarily Printing with Black Ink - Mac OS

Note:
To use this feature through a network, connect with Bonjour.

1.

2.

8.

9.

Click the printer icon in the Dock.

Cancel the job.

Note:
If you cannot cancel printing from the computer, cancel using the printer's control panel.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver).

Select On as the Permit temporary black printing setting.
Access the print dialog.

Select Print Settings from the pop-up menu.

Select plain papers or Envelope as the Media Type setting.
Select Grayscale.

Set the other items as necessary.

10. Click Print.

Conserving Black Ink when the Black Ink Is Low (for
Windows Only)

When black ink is running low and there is enough color ink remaining, you can use a mixture of color inks to
create black. You can continue printing while preparing a replacement black ink supply unit.

This feature is only available when you select the following settings in the printer driver.

[ Paper Type: plain papers
[ Quality: Standard
(J EPSON Status Monitor 3: Enabled
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Note:
[ If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and
then select Enable EPSON Status Monitor 3.

A Composite black looks slightly different from pure black. In addition, the print speed is reduced.

A To maintain the quality of the print head, black ink is also consumed.

EPSOM Status Monitor 3

Black ink is low. You can extend black ink supply unit life by printing with &
mixture of other colors to create composite black.
Do you want to do this for the current print job?

E Yes I

Mo

Disable this feature

Options Description

Yes Select to use a mixture of color inks to create black. This window is displayed the next time
you print a similar job.

No Select to continue using the remaining black ink. This window is displayed the next time
you print a similar job.

Disable this feature Select to continue using the remaining black ink. This window is not displayed until you
replace the black ink supply unit and it runs low again.
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Maintaining the Printer

Checking and Cleaning the Print Head

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. When
print quality has declined, use the nozzle check feature and check if the nozzles are clogged. If the nozzles are
clogged, clean the print head. You can perform a nozzle check and head cleaning from the control panel or the
computer.

n Important:

(A Do not open the ink supply unit tray or turn off the printer during head cleaning. If the head cleaning is
incomplete, you may not be able to print.

(A Because print head cleaning uses some ink, clean the print head only if quality declines.
[ When ink is low, you may not be able to clean the print head. Replace the ink supply unit first.

[ If print quality has not improved after repeating nozzle check and head cleaning about four times, wait for at
least six hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary.
We recommend to turn off the printer. If print quality has still not improved, contact Epson support.

(A To prevent the print head from drying out, do not unplug the printer while the power is on.

Checking and Cleaning the Print Head - Control Panel
1. Load A4-size plain paper in the paper cassette 1.
2. Select Maintenance on the home screen.
To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
3. Select Print Head Nozzle Check.
4. Follow the on-screen instructions to print the nozzle check pattern.

5. Examine the printed pattern. If there are broken lines or missing segments as shown in the "NG" pattern, the
print head nozzles may be clogged. Go to the next step. If you cannot see any broken lines or missing segments

as in the following "OK" pattern, the nozzles are not clogged. Select O to close the nozzle check feature.

OK NG

I
r!/:

l
i

Il
i

)

|

6. Select x, and then follow the on-screen instructions to clean the print head.
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7. When cleaning is finished, print the nozzle check pattern again. Repeat cleaning and printing the pattern until
all lines are printed completely.

Related Information

= “Loading Paper in the Paper Cassette” on page 26

Checking and Cleaning the Print Head - Windows
1. Load A4-size plain paper in the paper cassette 1.

2. Access the printer driver window.

3. Click Nozzle Check on the Maintenance tab.

4. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette” on page 26
= “Accessing the Printer Driver” on page 43

Checking and Cleaning the Print Head - Mac OS

1. Load A4-size plain paper in the paper cassette 1.

2. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

3. Click Options & Supplies > Utility > Open Printer Utility.
4. Click Nozzle Check.
5. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette” on page 26

Aligning the Print Head

If you notice a misalignment of vertical lines or blurred images, align the print head.

Aligning the Print Head - Control Panel

1. Load A4-size plain paper in the paper cassette 1.
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2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
3. Select Print Head Alignment.

4. Select one of the alignment menus.
[d Ruled Line Alignment: Select this if vertical ruled lines appear misaligned.

(J Horizontal Alignment: Select this if you see horizontal banding at regular intervals.
5. Follow the on-screen instructions to print an alignment pattern.

6. Follow the on-screen instructions to align the print head.

(J Ruled Line Alignment: Find and select the number for the most solid pattern in each group.

#1

Find and select the number for the pattern that has the least misaligned vertical line.

(d Horizontal Alignment: Find and select the number for the least separated and overlapping pattern.

p
p >
-

> .
.

Related Information

= “Loading Paper in the Paper Cassette” on page 26
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Cleaning the Paper Path for Ink Smears

When the printouts are smeared or scuffed, clean the roller inside.

g Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

1. Load A4-size plain paper in the paper source that you want to clean.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the AV 4 buttons, and then press the OK button.
3. Select Paper Guide Cleaning.

4. Select the paper source, and then follow the on-screen instructions to clean the paper path.

Note:
Repeat this procedure until the paper is not smeared with ink. If the printouts are still smeared, clean the other paper
sources.

Related Information

= “Loading Paper in the Paper Cassette” on page 26
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Network Service and Software
Information

This section introduces the network services and software products available for your printer from the Epson
website or the supplied software disc.

Application for Configuring Printer Operations (Web
Config)

Web Config is an application that runs in a web browser, such as Internet Explorer and Safari, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

The following browsers are supported.

(01 Browser
Windows XP SP3 or later Internet Explorer 8 or later, Firefox”, Chrome”
Mac OS X v10.6.8 or later Safari®, Firefox”, Chrome”
i0S” Safari”
Android 2.3 or later Default browser
Chrome OS” Default browser

* Use the latest version.

Running Web Config on a Web Browser

1. Check the printer's IP address.

Select the network icon on the printer's home screen, and then select the active connection method to confirm
the printer's IP address.

To select an item, move the focus to the item using the A ' 4P buttons, and then press the OK button.
Note:
You can also check the IP address by printing the network connection report.
2. Launch a Web browser from a computer or smart device, and then enter the printer's IP address.
Format:
IPv4: http://the printer's IP address/
IPv6: http://[the printer's IP address]/
Examples:

IPv4: http://192.168.100.201/
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IPv6: http://[2001:db8::1000:1]/

Note:
Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information

= “Using Epson iPrint” on page 74

Running Web Config on Windows

When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1. Access the devices and printers screen in Windows.

[ Windows 10/Windows Server 2016

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers
in Hardware and Sound.

[ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

[ Windows 7/Windows Server 2008 R2

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.

[ Windows Vista/Windows Server 2008

Click the start button, and select Control Panel > Printers in Hardware and Sound.
2. Right-click on your printer and select Properties.

3. Select the Web Service tab and click the URL.

Running Web Config on Mac OS

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies> Show Printer Webpage.

Application for Printing Web Pages (E-Web Print)

E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.

Note:
[ Windows Server operating systems are not supported.

(A Check for supported browsers and the latest version from the download site.
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Starting
When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Software Update Tools (Software Updater)

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's manual.

Note:
Windows Server operating systems are not supported.

Installing Method
Install Software Updater from the supplied software disc or download the latest version from the Epson website.

http://www.epson.com

Starting on Windows
(4 Windows 10
Click the start button, and then select Epson Software > EPSON Software Updater.
([ Windows 8.1/Windows 8
Enter the application name in the search charm, and then select the displayed icon.
[ Windows 7/Windows Vista/Windows XP
Click the start button, and then select All Programs (or Programs) > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS
Select Go > Applications > Epson Software > EPSON Software Updater.

Installing the Latest Applications

Note:
When reinstalling an application, you need to uninstall it first.

1. Make sure the printer and the computer are available for communication, and the printer is connected to the
Internet.
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2. Start EPSON Software Updater.

The screenshot is an example on Windows.

Egrson Software Updater

New software is available in the table below.

=20 Select your preduct ST 2.
Essential Product Updates
Software Status Version Size

< >

Other useful software

Software Status arsion Size

€ »

Auto update sattings Tatal = - MB
Exit

3. For Windows, select your printer, and then click T} to check for the latest available applications.

4. Select the items you want to install or update, and then click the install button.

n Important:

Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.

Note:
A You can download the latest applications from the Epson website.

http://www.epson.com

1 If you use Windows Server operating systems, you cannot use EPSON Software Updater. Download the latest
applications from the Epson website.

Related Information
= “Software Update Tools (Software Updater)” on page 94

Installing a PostScript Printer Driver

Installing a PostScript Printer Driver Using USB Interface - Windows

1. Turn off all virus protection applications.
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Insert the software disc that came with the printer into the computer, and download the "Driver/PostScript/
eppsnt.inf" file.

Note:
If your computer does not have a CD/DVD drive, download the printer driver from the Epson support website.

http://www.epson.eu/Support (Europe)
http://support.epson.net/ (outside Europe)

Connect the printer to the computer with a USB cable, and then turn on the printer.

Note:

For Windows Vista/Windows XP, when the Found New Hardware screen appears, click Ask me again later.
Add a printer.

(d Windows 10/Windows Server 2016

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers
in Hardware and Sound and then click Add a Printer.

[ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound, and then
click Add a Printer.

[ Windows 7/Windows Server 2008 R2

Click the start button, select Control Panel > View devices and printers in Hardware and Sound, and then
click Add a Printer.

[J Windows Vista/Windows Server 2008

Click the start button, select Control Panel > Printers in Hardware and Sound, and then click Add a
Printer.

[ Windows XP/Windows Server 2003 R2/Windows Server 2003

Click the start button, select Control Panel > Printers and Other Hardware > Printers and Faxes > Add a
Printer, and then click Next.

Add alocal printer.

J Windows 10/Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Click The printer that I want isn't listed, select Add a local printer or network printer with manual
settings, and then click Next.

[ Windows 7/Windows Vista/Windows Server 2008 R2/Windows Server 2008
Click Add a local printer.

[J Windows XP/Windows Server 2003 R2/Windows Server 2003

Select Local printer attached to this computer, clear Automatically detect and install my Plug and Play
printer, and then click Next.

Select Use an existing port, select USB001 (Virtual printer port for USB), and then click Next.

Click Have Disk, specify the "eppsnt.inf" file that is on the software disc or that you have downloaded from the
website, and then click OK.

Select your printer, and then click Next.

Follow the on-screen instructions for the rest of the installation.
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Installing a PostScript Printer Driver Using Network Interface -

Windows
1. Turn off all virus protection applications.
2. Insert the software disc that came with the printer into the computer, and download the "Driver/PostScript/
eppsnt.inf" file.
Note:
If your computer does not have a CD/DVD drive, download the printer driver from the Epson support website.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (outside Europe)
3. Add a printer.
1 Windows 10/Windows Server 2016
Right-click the start button or press and hold it, and then select Control Panel > View devices and printers
in Hardware and Sound and then click Add a Printer.
(1 Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound, and then
click Add a Printer.
[ Windows 7/Windows Server 2008 R2
Click the start button, select Control Panel > View devices and printers in Hardware and Sound, and then
click Add a Printer.
[ Windows Vista/Windows Server 2008
Click the start button, select Control Panel > Printers in Hardware and Sound, and then click Add a
Printer.
(4 Windows XP/Windows Server 2003 R2/Windows Server 2003
Click the start button, select Control Panel > Printers and Other Hardware > Printers and Faxes > Add a
Printer, and then click Next.
4. Add alocal printer.
[ Windows 10/Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Click The printer that I want isn't listed, select Add a local printer or network printer with manual
settings, and then click Next.
4 Windows 7/Windows Vista/Windows Server 2008 R2/Windows Server 2008
Click Add a local printer.
(1 Windows XP/Windows Server 2003 R2/Windows Server 2003
Select Local printer attached to this computer, clear Automatically detect and install my Plug and Play
printer, and then click Next.
5. Select Create a new port, select Standard TCP/IP Port, and then click Next.

Note:
For Windows XP/Windows Server 2003 R2/Windows Server 2003, when the Add Standard TCP/IP Printer Port
Wizard screen appears, click Next.
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6. Enter the printer's IP address, and then click Next.

Note:
(A Select the network icon on the printer's home screen, and then select the active connection method to confirm the
printer’s IP address.

[ For Windows XP/Windows Server 2003 R2/Windows Server 2003, when the Add Standard TCP/IP Printer Port

Wizard screen appears, click Finish.

7. Click Have Disk, specify the "eppsnt.inf" file that is on the software disc or that you have downloaded from the
website, and then click OK.

8. Select your printer, and then click Next.

9. Follow the on-screen instructions for the rest of the installation.

Installing a PostScript Printer Driver - Mac OS

Download the printer driver from the Epson Support website, and then install it.
http://www.epson.eu/Support (Europe)

http://support.epson.net/ (outside Europe)

You need the IP address of the printer while installing the printer driver.

Select the network icon on the printer's home screen, and then select the active connection method to confirm the
printer's IP address.

Adding the Printer Driver (for Mac OS Only)

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax).
2. Click +, and then select Add Other Printer or Scanner.

3. Select your printer, and then click Add.

Note:
A If your printer is not listed, check that it is correctly connected to the computer and that the printer is on.

(A For a USB, IP, or Bonjour connection, set the optional paper cassette unit manually after adding the printer driver.

Installing the Epson Universal Printer Driver (for
Windows Only)

The Epson universal printer driver is the universal PCL6 compatible print driver. Once you install this printer
driver’, you can print from every Epson printer that supports this printer driver.

* Since this is a generic printer driver, printing features are limited compared to the printer driver specifically designed for this
printer.

Connect the printer to the same network as the computer, and then follow the procedure below to install the
printer driver.
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1. Download the executable file of the driver from the Epson support website.
http://www.epson.eu/Support (Europe only)
http://support.epson.net/

2. Double-click the executable file.

3. Follow the on-screen instructions for the rest of the installation.

Note:
If you are using a Windows computer and you cannot download the driver from the website, install it from the software
disc that came with the printer. Access "Driver\Universal".

Uninstalling Applications

Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the ) button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:
(d Windows 10/Windows Server 2016
Right-click the start button or press and hold it, and then select Control Panel.
(J Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel.

[J Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server
2003 R2/Windows Server 2003

Click the start button and select Control Panel.

4. Open Uninstall a program (or Add or Remove Programs):

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/ Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008

Select Uninstall a program in Programs.

[ Windows XP/Windows Server 2003 R2/Windows Server 2003
Click Add or Remove Programs.

5. Select the application you want to uninstall.
You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before
uninstalling.

6. Uninstall the applications:

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/ Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008

Click Uninstall/Change or Uninstall.
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[ Windows XP/Windows Server 2003 R2/Windows Server 2003

Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

7. Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1. Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

2. Press the O button to turn off the printer.

3. To uninstall the printer driver, select System Preferences from the ‘ menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

4. Quit all running applications.
5. Select Go > Applications > Epson Software > Uninstaller.

6. Select the application you want to uninstall, and then click Uninstall.

n Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.

Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Printing Using a Network Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere. To use this service, you need to register the user and the printer in
Epson Connect.

The features available on the Internet are as follows.

[ Email Print

When you send an email with attachments such as documents or images to an email address assigned to the
printer, you can print that email and the attachments from remote locations such as your home or office printer.

(A Epson iPrint

This Application is for iOS and Android, and allows you to print from a smart phone or tablet. You can print
documents, images, and websites by sending them directly to a printer on the same wireless LAN.
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[ Remote Print Driver

This is a shared driver supported by Remote Print Driver. When printing using a printer in a remote location,
you can print by changing the printer on the usual applications window.

See the Epson Connect portal website for details.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Related Information

= “Using Epson iPrint” on page 74
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Checking the Printer Status

Checking Messages on the LCD Screen

If an error message is displayed on the LCD screen, follow the on-screen instructions or the solutions below to
solve the problem.

Error Messages

Solutions

Printer Error

Turn on the printer again. See your
documentation for more details.

1 Remove any paper or protective material in the printer and the paper
cassette. If the error message is still displayed after turning the power
off and on again, contact Epson support.

1 When the following error codes are displayed, check the paper for
the maximum number of sheets that can be loaded in each paper
source.

000181, 000184

Paper out in XX.

Load paper, and then insert the paper cassette all the way.

Cannot print because XX is out of order. You can
print from another cassette.

Turn the power off and on again, and then reinsert the paper cassette. If
the error message is still displayed, contact Epson support or an
authorised Epson service provider to request repairs.

You need to replace Ink Supply Unit(s).

To ensure you receive premium print quality and to help protect your
print head, a variable ink safety reserve remains in the ink supply unit
when your printer indicates it is time to replace the ink supply unit.
Replace to new ink supply units.

Paper Configuration is disabled. Some features
may not be available. For details, see your
documentation.

If Paper Setup Auto Display is disabled, you cannot use AirPrint.

The combination of the IP address and the
subnet mask is invalid. See your documentation
for more details.

Contact your printer administrator.

To use cloud services, update the root certificate
from the Epson Web Config utility.

Contact your printer administrator.

Check that the printer driver is installed on the
computer and that the port settings for the
printer are correct.

Check that the printer driver is installed on the
computer and that the USB port settings for the
printer are correct.

Make sure the printer port is selected correctly in Property > Port from
the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a
network connection.

Recovery Mode

Contact your printer administrator.

Related Information

= “Contacting Epson Support” on page 140
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= “Software Update Tools (Software Updater)” on page 94
= “Installing the Latest Applications” on page 94

Checking the Printer Status - Windows
1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab, and then click Details.
You can check the printer status, ink levels, and error status.

Note:
If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

= “Accessing the Printer Driver” on page 43

Checking the Printer Status - Mac OS

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

You can check the printer status, ink levels, and error status.

Checking the Software Status

You may be able to clear the problem by updating the software to the latest version. To check the software status,
use the software update tool.

Related Information
= “Software Update Tools (Software Updater)” on page 94
= “Installing the Latest Applications” on page 94

Removing Jammed Paper

Follow the on-screen instructions on the printer's control panel to locate and remove the jammed paper including
any torn pieces. The LCD screen displays an animation that shows you how to remove jammed paper.
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A Caution:

Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it
could cause an injury. Be careful not to touch the protruding parts to avoid injury.

n Important:

Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

Paper Does Not Feed Correctly

Check the following points, and then take the appropriate actions to solve the problem.

[ Place the printer on a flat surface and operate in the recommended environmental conditions.
[d Use paper supported by this printer.

[ Follow the paper handling precautions.

(4 Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load

above the line indicated by the symbol on the edge guide. For thick paper such as photo paper, do not

v
load above the line indicated by the === symbol on the edge guide.

[ Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

(4 Ifa paper feed problem frequently occurs, feed paper from another paper source.

Related Information

= “Environmental Specifications” on page 124
= “Paper Handling Precautions” on page 25
= “Available Paper and Capacities” on page 21
= “List of Paper Type” on page 32

Paper Jams

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[d Load one sheet of paper at a time if you have loaded several sheets of paper.

Related Information

= “Removing Jammed Paper” on page 103

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28

Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.
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Related Information
= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28

Several Sheets of Paper are Fed at a Time

When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is loaded
in the printer before you reload the paper.

Paper Does Not Feed from the Optional Paper Cassette Unit

If you have added optional paper cassette unit, you need to make settings in the printer driver.

Related Information
= “Setting the Optional Paper Cassette Unit in the Printer Driver - Windows” on page 132
= “Setting the Optional Paper Cassette Unit in the Printer Driver - Mac OS” on page 133

Paper Out Error Occurs

When a paper out error occurs although paper is loaded in the rear paper feed, reload paper in the center of the
rear paper feed.

Power and Control Panel Problems

Power Does Not Turn On

[d Make sure the power cord is securely plugged in.

2 Hold down the O button for a little longer.

Power Does Not Turn Off

Hold down the O button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the O button.

Power Turns Off Automatically

[ Select Settings > General Settings > Basic Settings > Power Off Settings, and then disable the Power Off If
Inactive and Power Off If Disconnected settings.

[ Select Settings > General Settings > Basic Settings, and then disable the Power Off Timer setting.
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Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

LCD Screen Gets Dark

The printer is in sleep mode. Press any button on the control panel to return the LCD screen to its former state.

Cannot Operate from the Control Panel

When the user feature restriction is enabled, a user ID and password are required to print. If you do not know the
password, contact your printer administrator.

Cannot Print from a Computer

Checking the Connection (USB)

[d Connect the USB cable securely to the printer and the computer.
[ If you are using a USB hub, try to connect the printer directly to the computer.
[ If the USB cable cannot be recognized, change the port, or change the USB cable.

[ If the printer cannot print using a USB connection, try the following.

Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and
then select Remove Device. Next, connect the USB cable to the computer and try a test print.

Re-set the USB connection by following the steps in this manual for changing the connection method to a
computer. See the related information link below for details.

~ Printers (19)

a8 <

Open
KXKXX Series |

Open in new window

See what's printing
e St as default printer
— Printing preferences ‘

Printer properties
Create shortcut
)E&S;j;'xxxﬂ & Remove device l') (EL‘
Series | roubleshoo

Properties
P e

OO0 Series Manufacturer:  Seib
- Model: XX

= Description: Eps

Checking the Connection (Network)

[ Select Settings > General Settings > Network Settings > Connection Check, and then print the network
connection report. If the report shows that network connection has failed, check the network connection report
and then contact your printer administrator.

[ If the problem cannot be cleared, contact your printer administrator.
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Checking the Software and Data

[d Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the
available functions are limited. We recommend using a genuine Epson printer driver. See the related
information link below for details.

[ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

Related Information

= “Checking for Genuine Epson Printer Drivers” on page 107

Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to
open the print server properties window.

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Server 2016/Windows Server 2012 R2/Windows
Server 2012/Windows Server 2008 R2

Click the printer icon, and then click Print server properties at the top of the window.

[ Windows Vista/Windows Server 2008

Right-click on the Printers folder, and then click Run as administrator > Server Properties.

(d Windows XP/Windows Server 2003 R2/Windows Server 2003

From the File menu, select Server Properties.
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Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.

& Devices and Printers

« « 4 x> Control Panel + Hardware and Sound > Devices and Printers * ve

Fle Edit View Tools Help

Piflodzie Gdfloprim Smofmieprmees Fammmisies

v Printers (19) 8 Print Server Properties X
Foms pmecw avancad
- -
<N ;' HRXXKKNHNHXK
L
XXXXX Series
Installed printer drivers:
e
Ty MName Processor Type &
— EPSON X3OXXXX Series 3 - User Mode
EPSON
OO
Series
-
XXX
-
——
v
Add... Remove... Properties
O Change Driver Settings
Sance oy
Mac OS

Select System Preferences from the :‘. menu > Printers & Scanners (or Print & Scan, Print & Fax), and then

select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Printers & Scanners

General Supply Levels| mmw |

Open Printer Utility
Print Test Page

Clean Print Heads

concel_ (N

Related Information

= “Installing the Latest Applications” on page 94
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Checking the Printer Status from the Computer (Windows)

Click Print Queue on the printer driver's Maintenance tab, and then check the following.

5 EPSON JOOCODOOGK  Printing Preferences x
Min Mors Dptisas Mantenwnce
Hozse Chedk El EPEOM Status Moritor 3

‘p;, Head Cleanng g‘ Monioring Preferences

@ 3ob Arranger Lie %l Frinter and Opson Enformation

Langrusge Bust Select - W softare Lpdate

Techrical Suppert

ok Conael ¢ Hep

[ Check if there are any paused print jobs.
If unnecessary data remains, select Cancel all documents from the Printer menu.
[d Make sure the printer is not offline or pending.

If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

EPSOMN JOONN00L Series o %

Priner  Document  View

& Set s Defaut Printer
Printing Preferences..

Pase Priseng ,

Caneel Al Decurments

[d Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on
the menu item).

If the printer is not selected as the default printer, set it as the default printer. If there are multiple icons in
Control Panel > View devices and printers (Printers, Printers and Faxes), see the following to select the icon.

Example)
USB connection: EPSON XXXX Series
Network connection: EPSON XXXX Series (network)

If you install the printer driver multiple times, copies of printer driver may be created. If copies such as "EPSON
XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove Device.

[d Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a network connection.

Checking the Printer Status from the Computer (Mac OS)

(d The printer may not print when the user feature restriction is enabled. Contact your printer administrator.
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[d Make sure the printer status is not Pause.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).

Cannot Print from an iPhone or iPad

[d Connect the iPhone or iPad to the same network (SSID) as the printer.

(d Enable Paper Setup Auto Display in the following menus.
Settings > General Settings > Printer Settings > Paper Source Settings > Paper Setup Auto Display

[J Enable the AirPrint setting on Web Config.

Related Information

= “Application for Configuring Printer Operations (Web Config)” on page 92

Printout Problems

Adjusting the Print Quality
If you notice a misaligned vertical lines, blurred images, or horizontal banding, adjust the print quality.
1. Load A4-size plain paper in the paper cassette 1.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the A W 4P buttons, and then press the OK button.
3. Select Print Quality Adjustment.

4. Follow the on-screen instructions to check the printer to improve print quality.

If a message is displayed recommending that you clean the print head, perform print head cleaning.

5. Follow the on-screen instructions to print the patterns for print head alignment, and then align the print head.

[ This pattern allows you to perform alignment if your printouts look blurry.

Find and select the number for the most solid pattern in each group.

#1

| | 1] ]
3 4
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[ This pattern allows you to perform alignment if vertical ruled lines appear misaligned.

Find and select the number for the pattern that has the least misaligned vertical line.

[ This pattern allows you to perform alignment if you see horizontal banding at regular intervals.
Find and select the number for the least separated and overlapping pattern.
p

p >
- .

>
>

‘) [m]

Related Information

= “Loading Paper in the Paper Cassette” on page 26

Printout is Scuffed or Color is Missing

If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not be
discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

Related Information

= “Checking and Cleaning the Print Head” on page 88

Banding or Unexpected Colors Appear

!

u*"
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The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged.
Clean the print head if any of the print head nozzles are clogged.

Related Information
= “Checking and Cleaning the Print Head” on page 88

Colored Banding Appears at Intervals of Approximately 3.3 cm

[ Select the appropriate paper type setting for the type of paper loaded in the printer.
[ Align the print head using the Print Quality Adjustment feature.
(d When printing on plain paper, print using a higher quality setting.

Related Information

= “List of Paper Type” on page 32
= “Adjusting the Print Quality” on page 110

Blurry Prints, Vertical Banding, or Misalignment

CTTralcn ailc

y Aufdruck. W

Align the print head using the Print Quality Adjustment feature.

Related Information

= “Adjusting the Print Quality” on page 110
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Print Quality Does Not Improve Even After Aligning the Print Head

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and vertical
lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed) setting.
Disabling this setting may slow down printing speed.

(d Windows
Clear High Speed on the printer driver’s More Options tab.

[ Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed Printing
setting.

Print Quality is Poor

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and
misalignment in the prints.

Checking the printer
Use the Print Quality Adjustment feature.
[d Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

[ Align the print head.

Checking the paper

[d Use paper supported by this printer.

d Do not print on paper that is damp, damaged, or too old.
[ If the paper is curled or the envelope is puffed up, flatten it.
1 Do not stack the paper immediately after printing.

(d Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.

(4 When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

Checking the print settings
[ Select the appropriate paper type setting for the type of paper loaded in the printer.
[ Print using a higher quality setting.

[ If you have selected Standard-Vivid as the quality setting on the Windows printer driver, change to Standard. If
you have selected Normal-Vivid as the quality setting on the Mac OS printer driver, change to Normal.

Checking the ink supply unit

([ Try to use genuine Epson ink supply units. This product is designed to adjust colors based on the use of genuine
Epson ink supply units. The use of non-genuine ink supply units may cause print quality to decline.

(d Epson recommends using the ink supply unit before the date printed on the package.
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Related Information

= “Adjusting the Print Quality” on page 110
= “Available Paper and Capacities” on page 21
= “List of Paper Type” on page 32

= “Paper Handling Precautions” on page 25

Paper Is Smeared or Scuffed

(4 When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct
direction and slide the edge guides to the edges of the paper.

R v

[ When vertical banding appears or the paper is smeared, clean the paper path.

|V

[ Place the paper on a flat surface to check if it is curled. If it is, flatten it.

(d When printing on thick paper, the print head is close to the printing surface and the paper may be scuffed. In
this case, enable the reduce scuff setting. If you enable this setting, print quality may decline or printing may
slow down.

(d Control panel
Select Settings > General Settings > Printer Settings from the home screen, and then enable Thick Paper.

[d Windows

Click Extended Settings on the printer driver's Maintenance tab, and then select Thick Paper and
Envelopes.

d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as theThick paper and
envelopes setting.

(d When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.
Related Information

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28
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= “Cleaning the Paper Path for Ink Smears” on page 91

Paper is Smeared During Automatic 2-Sided Printing
When using the automatic 2-sided printing feature and printing high density data such as images and graphs, set

the print density to lower and the drying time to longer.

Related Information

= “Printer Settings” on page 34

Printed Photos are Sticky

You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.

When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

= “Cleaning the Paper Path for Ink Smears” on page 91

Images or Photos are Printed in Unexpected Colors

Adjust the color and then print again. The automatic color correction feature uses the standard correction mode in
PhotoEnhance. Try another correction mode in PhotoEnhance by selecting an option other than Auto Correct as
the Scene Correction setting. If the problem continues, use any other color correction feature other than
PhotoEnhance.

Related Information

= “Adjusting the Print Color” on page 58

The Position, Size, or Margins of the Printout Are Incorrect

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.
[ Select the appropriate paper size setting.

(d Adjust the margin setting in the application so that it falls within the printable area.

Related Information

= “Loading Paper in the Paper Cassette” on page 26
= “Loading Paper in the Rear Paper Feed” on page 28
= “Printable Area” on page 120

Printed Characters Are Incorrect or Garbled

[d Connect the USB cable securely to the printer and the computer.
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(4 If there are any paused print jobs, printed characters may be corrupted.

(d Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

[ If you use the printer driver you had previously used, printed characters may be garbled. Make sure that the
printer driver you are using is for this printer. Check the printer name on the top of the printer driver window.

The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.
1 Windows
Clear Mirror Image on the printer driver's More Options tab.

J Mac OS

Clear Mirror Image from the print dialog's Print Settings menu.

Mosaic-Like Patterns in the Prints

When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

Unintentionally Printing on 2-Sides

Clear any 2-sided printing settings in the printer driver.

(d Windows
Select Off from 2-Sided Printing on the printer driver's Main tab.

d Mac OS
Select Off from Two-sided Printing on the print dialog's Two-sided Printing Settings menu.

The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information

= “Uninstalling Applications” on page 99
= “Installing the Latest Applications” on page 94
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Other Printing Problems

Printing Is Too Slow

[d Close any unnecessary applications.
[d Lower the quality setting. High quality printing slows down the printing speed.

[d Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

J Windows
Select High Speed on the printer driver's More Options tab.

[d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.

[d Disable quiet mode. This feature slows down the printing speed.

[d Control Panel

Select on the home screen, and then disable Quiet Mode.

J Windows
Select Off as the Quiet Mode setting on the printer driver's Main tab.

[d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

[ For 2-sided printing, one side of paper is printed and dried, and then the other side is printed. Because the
drying time differs depending on the environment, such as temperature or humidity, or the print data, the
printing speed may be slower.

Printing Slows Down Dramatically During Continuous Printing

Printing slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue printing. To return to normal printing speed, leave the printer idle for at least 30 minutes. Printing speed
does not return to normal if the power is off.

Cannot Cancel Printing from a Computer Running Mac OS Xv10.6.8

If you want to stop printing from your computer, make the following settings.
Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select System

Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and
then add the printer again.
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PostScript Printer Driver Problems

Note:
The menu items and text on the printer driver vary depending on your computer's environment.

Printer Does Not Print While Using PostScript Printer Driver

[d Set the Printing Language setting to Auto or PS3 on the control panel.

(J In Windows, if a large number of jobs are sent, the printer may not print. Select Print directly to the printer on
the Advanced tab in the printer properties.

Related Information

= “Printer Settings” on page 34

Printer Does Not Print Correctly While Using PostScript Printer
Driver

[ If the file is created in an application that allows you to change the data format, such as Adobe Photoshop, make
sure that the settings in the application match the settings in the printer driver.

(d EPS files made in binary format may not be printed correctly. Set the format to ASCII when making EPS files in
an application.

(d For Windows, the printer cannot print binary data when it is connected to the computer using a USB interface.
Set the Output Protocol setting on the Device Settings tab in the printer properties to ASCII or TBCP.

(J For Windows, select the appropriate substitution fonts on the Device Settings tab in the printer properties.

Print Quality Is Poor While Using PostScript Printer Driver

You cannot make color settings on the Paper/Quality tab in the printer driver. Click Advanced, and then set the
Color Mode setting.

Printing Is Too Slow While Using PostScript Printer Driver

Set the Print Quality setting to Fast in the printer driver.

Other Problems

Slight Electric Shock when Touching the Printer

If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer.
Install a ground wire to the computer that is connected to the printer.
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Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

(d Control panel

LA
Select @@ on the home screen, and then enable Quiet Mode.

(d Windows printer driver

Enable Quiet Mode on the Main tab.
(d Mac OS printer driver

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

Forgot Your Password

If you forget the administrator's password, contact Epson support.

Related Information

= “Contacting Epson Support” on page 140

Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.
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Technical Specifications
Printer Specifications
Print Head Nozzle Placement Black ink nozzles: 800

Color ink nozzles: 800 for each color

Weight of Paper* | Plain Paper 64 to 90 g/m*(17 to 24lb)
Thick Paper 91 to 256 g/m’* (25 to 68 Ib)
Envelopes Envelope #10, DL, C6: 75 to 90 g/m? (20 to 24 Ib)
Envelope C4: 80 to 100 g/m? (21 to 26 Ib)

* Even when the paper thickness is within this range, the paper may not feed in the printer or print result may adversely
affected depending on the paper property or quality.

Printable Area

Print quality may decline in the shaded areas due to the printer's mechanism.

Single sheets
AH j c A 3.0mm (0.12in.)
B 3.0mm (0.12in.)
C 47.0mm (1.851in.)
D 45.0mm (1.77 in.)
Ax o
H H
B B
Envelopes
AR IC A 3.0mm (0.12in.)
\ B Except for C4:
,’I 5.0 mm (0.20in.)
N ! ID C4:
T T 9.5 mm (0.37in.)
B B
C 18.0mm (0.71 in.)
D 47.0 mm (1.85in.)
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For Computer Hi-Speed USB
Network Function List
Network Functions and IPv4/IPv6
Functions Supported Remarks
Network Printing EpsonNet Print (Windows) IPv4 v -
Standard TCP/IP (Windows) IPv4, IPv6 v -
WSD Printing (Windows) IPv4, IPv6 v Windows Vista or
later
Bonjour Printing (Mac OS) IPv4, IPv6 v -
IPP Printing (Windows, Mac IPv4, IPv6 v -
05s)
UPnP Printing IPv4 - Information
appliance
PictBridge Printing (Wi-Fi) IPv4 - Digital camera
Epson Connect (Email Print, IPv4 v -
Remote Print)
AirPrint (i0S, Mac OS) IPv4, IPv6 v iOS 5 or later, Mac
OS Xv10.7 or later
Google Cloud Print IPv4, IPv6 v -
Network Scanning Epson Scan 2 IPv4, IPv6 - -
Event Manager IPv4 - -
Epson Connect (Scan to IPv4 - -
Cloud)
AirPrint (Scan) IPv4, IPv6 - -
ADF (2-sided scanning) - -
Fax Send a fax IPv4 - -
Receive a fax IPv4 - -
AirPrint (Faxout) IPv4, IPv6 - -

Wi-Fi Specifications

Standards

IEEE802.11b/g/n"172
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Frequency Range 24 GHz
Maximum Radio-Frequency 19.8 dBm (EIRP)
Power Transmitted
Coordination Modes Infrastructure, Wi-Fi Direct (Simple AP) "3"4
Wireless Securities WEP (64/128bit), WPA2-PSK (AES)*5, WPA2-Enterprise

*1  Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2  |EEE802.11n is only available for the HT20.

*3  Not supported for IEEE 802.11b.

*4  Simple AP mode is compatible with a Wi-Fi connection (infrastructure) or an Ethernet connection.

*5  Complies with WPA2 standards with support for WPA/WPA2 Personal.

Ethernet Specifications

Standards IEEE802.3i (10BASE-T)"1
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T)"

IEEE802.3az (Energy Efficient Ethernet)™2

Communication Mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full duplex, 100Mbps
Half duplex
Connector RJ-45

*1  Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

*2  The connected device should comply with IEEE802.3az standards.

Security Protocol

IEEE802.1X"

IPsec/IP Filtering

SSL/TLS HTTPS Server/Client

IPPS

SMTPS (STARTTLS, SSL/TLS)

SNMPv3

* You need to use a device for connection that complies with [EEE802.1X.

PostScript Level 3 Compatibility

The PostScript used on this printer is compatible with PostScript Level 3.
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Supported Third Party Services

AirPrint Print

iOS 5 or later/Mac OS X v10.7.x or later

Google Cloud Print

Dimensions

Only the printer

Dimensions Storage

1 Width: 425 mm (16.7 in.)
1 Depth™:535 mm (21.1in.)
1 Height: 357 mm (14.1in.)

Printing

1 Width: 425 mm (16.7 in.)
1 Depth:578 mm (22.8in.)
1 Height: 449 mm (17.7in.)

Weight ™2 Approx. 15.3 kg (33.7 Ib)

*1  With the output tray installed.

*2  Without the ink supply units and the power cord.

Printers with option

These are the dimensions of printers with 1 optional paper cassette unit.

Dimensions Storage

1 Width: 425 mm (16.7 in.)
O Depth™:535 mm (21.1in.)
4 Height: 457 mm (18.0in.)

Printing

1 Width: 425 mm (16.7 in.)
[ Depth:577 mm (22.7 in.)
4 Height: 549 mm (21.6in.)

Weight2 Approx. 19.9 kg (43.9 Ib)

*1  With the output tray installed.

*2  Without the ink supply units and the power cord.
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Electrical Specifications
Model 100 to 240 V Model 220 to 240 V Model
Rated Frequency Range 50 to 60 Hz 50 to 60 Hz
Rated Current 0.6t00.3A 03A

Power Consumption (with USB Con-
nection)

Printing: Approx. 22 W (ISO/IEC24712)
Ready mode: Approx. 7 W

Sleep mode: Approx. 1.2 W

Power off: Approx. 0.2 W

Printing: Approx. 22 W (ISO/IEC24712)
Ready mode: Approx. 7 W

Sleep mode: Approx. 1.2 W

Power off: Approx. 0.2 W

Note:

(A Check the label on the printer for its voltage.

(A For European users, see the following Website for details on power consumption.

http://www.epson.eu/energy-consumption

Environmental Specifications

Operation Use the printer within the range shown in the following graph.
%
80
55
20
10 27 35 ©
Temperature: 10 to 35°C (50 to 95°F)
Humidity: 20 to 80% RH (without condensation)
Storage Temperature: -20 to 40°C (-4 to 104°F)"

Humidity: 5 to 85% RH (without condensation)

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Supply Units

Storage Temperature

-30 to 40 °C (-22 to 104 °F)"

Freezing Temperature

-13°C (8.6 °F)

Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

You can store for one month at 40 °C (104 °F).
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System Requirements

[ Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-
bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2
or later/Windows Server 2016/Windows Server 2012 R2/Windows Server 2012/Windows Server 2008 R2/
Windows Server 2008/Windows Server 2003 R2/Windows Server 2003 SP2 or later

[d macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac OS X v10.7.x/Mac

0OS X v10.6.8

Note:

[ Mac OS may not support some applications and features.

(A The UNIX File System (UFS) for Mac OS is not supported.

Font Information

Available Fonts for PostScript

Font Name

Family

HP Equivalent

Nimbus Mono

Medium, Bold, Italic, Bold Italic

Courier

Letter Gothic

Medium, Bold, Italic

Letter Gothic

Nimbus Mono PS Regular, Bold, Oblique, Bold Oblique CourierPS

Nimbus Roman No4 Medium, Bold, Italic, Bold Italic CG Times

URW Classico Medium, Bold, Italic, Bold Italic CG Omega

URW Coronet - Coronet

URW Clarendon Condensed - Clarendon Condensed
URW Classic Sans Medium, Bold, Italic, Bold Italic Univers

URW Classic Sans Condensed

Medium, Bold, Italic, Bold Italic

Univers Condensed

Antique Olive Medium, Bold, Italic Antique Olive
Garamond Antiqua, Halbfett, Kursiv, Kursiv Halbfett Garamond
Mauritius - Marigold
Algiers Medium, Extra Bold Albertus
NimbusSansNo2 Medium, Bold, Italic, Bold Italic Arial

Nimbus Roman No9

Medium, Bold, Italic, Bold Italic

Times New Roman

Nimbus Sans

Medium, Bold, Oblique, Bold Oblique

Helvetica

Nimbus Sans Narrow

Medium, Bold, Oblique, Bold Oblique

Helvetica Narrow

Palladio

Roman, Bold, Italic, Bold Italic

Palatino

URW Gothic

Book, Demi, Book Oblique, Demi Oblique

ITC Avant Garde
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Font Name

Family

HP Equivalent

URW Bookman

Light, Demi, Light Italic, Demi Italic

ITC Bookman

URW Century Schoolbook

Roman, Bold, Italic, Bold Italic

New Century Schoolbook

Nimbus Roman

Medium, Bold, Italic, Bold Italic

Times

URW Chancery Medium ltalic

ITC Zapf Chancery Italic

Symbol - Symbol
URW Dingbats - Wingdings
Dingbats - ITC Zapf Dingbats
Standard Symbol - SymbolPS
Available Fonts for PCL (URW)
Scalable Font
Font Name Family HP Equivalent Symbol
Set for
PCL5
Nimbus Mono Medium, Bold, Italic, Bold Italic Courier 1
Letter Gothic Medium, Bold, Italic Letter Gothic 1
Nimbus Mono PS Regular, Bold, Oblique, Bold Oblique CourierPS 3
Nimbus Roman No4 Medium, Bold, Italic, Bold Italic CGTimes 2
URW Classico Medium, Bold, Italic, Bold Italic CG Omega 3
URW Coronet - Coronet 3
URW Clarendon Condensed - Clarendon Condensed 3
URW Classic Sans Medium, Bold, Italic, Bold Italic Univers 2
URW Classic Sans Medium, Bold, Italic, Bold Italic Univers Condensed 3
Condensed
Antique Olive Medium, Bold, Italic Antique Olive 3
Garamond Antiqua, Halbfett, Kursiv, Kursiv Halbfett Garamond 3
Mauritius - Marigold 3
Algiers Medium, Extra Bold Albertus 3
NimbusSansNo2 Medium, Bold, Italic, Bold Italic Arial 3
Nimbus Roman No9 Medium, Bold, Italic, Bold Italic Times New 3
Nimbus Sans Medium, Bold, Oblique, Bold Oblique Helvetica 3
Nimbus Sans Narrow Medium, Bold, Oblique, Bold Oblique Helvetica Narrow 3
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Font Name Family HP Equivalent Symbol
Set for
PCL5
Palladio Roman, Bold, Italic, Bold Italic Palatino 3
URW Gothic Book, Demi, Book Oblique, Demi Oblique ITC Avant Garde Gothic 3
URW Bookman Light, Demi, Light Italic, Demi Italic ITC Bookman 3
URW Century Schoolbook Roman, Bold, Italic, Bold Italic New Century Schoolbook 3
Nimbus Roman Medium, Bold, Italic, Bold Italic Times 3
URW Chancery Medium - ITC Zapf Chancery Medium 3
Italic Italic
Symbol - Symbol 4
URW Dingbats - Wingdings 5
Dingbats - ITC Zapf Dingbats 6
Standard Symbol - SymbolPS 4
URW David Medium, Bold HP David 7
URW Narkis Medium, Bold HP Narkis 7
URW Miryam Medium, Bold, Italic HP Miryam 7
URW Koufi Medium, Bold Koufi 8
URW Naskh Medium, Bold Naskh 8
URW Ryadh Medium, Bold Ryadh 8
Bitmap Font
Font Name Symbol
Set
Line Printer 9
OCR/Barcode Bitmap Font (for PCL5 only)
Font Name Family Symbol
Set
OCRA - 10
OCRB - 1
Code39 9.37¢pi, 4.68cpi 12
EAN/UPC Medium, Bold 13
Note:

Depending on the print density, or on the quality or color of the paper, OCR A, OCR B, Code39, and EAN/UPC fonts may

not be readable. Print a sample and make sure the fonts can be read before printing large quantities.
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List of Symbol Sets

Your printer can access a variety of symbol sets. Many of these symbol sets differ only in the international
characters specific to each language.

When you are considering which font to use, you should also consider which symbol set to combine with the font.

Note:

Since most software handles fonts and symbols automatically, you will probably never need to adjust the printer’s settings.
However, if you are writing your own printer control programs, or if you are using older software that cannot control fonts,
refer to the following sections for symbol set details.

List of Symbol Sets for PCL 5

Symbol Set Attribute Font Classification
Name

1 2 3 4 5 6 7 8 9 10 11 12 13
Norweg1 oD v v v - - - - - - - - - -
Roman OE - - - - - - - - v/ - - - -
Extension
Italian ol v v v - - - - - - - - - -
ECM94-1 ON ol v | v |- - - - - Voo - - .
Swedis2 0S v 4 v - - - - - - - - - -
ANSI ASCII ou ol v | v |- - - ol v o - - - _ .
UK 1E v v v - - - - - - - - - -
French2 1F v v v - - - - - - - - - -
German 1G 4 v v - - - - - - - . - .
Legal 1 v v v - - - - - v - - - -
8859-2 15O 2N v olv | v |- - - y - v |- . _ .
Spanish 2S v v v - - - - - - - . - -
ISO 8859/4 4N v v v - - - - - - - - - -
Latin 4
Roman-9 4U 4 4 v - - - - - - - - - -
PsMath 5M v v v - - - v v - - - - -
8859-9 1SO 5N o v o v - - - - - v - - . .
WiTurkish 5T v v v - - - - - - - - - -
MsPublishin 6J v v v - - - - - - - - - -
VeMath 6M v v v - - - - - - - - - -
8859-10I1SO 6N v v v - - - - - v - - - -
DeskTop 7) v v v - - - - - - - - - -
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Symbol Set Attribute Font Classification
Name
1 2 3 4 5 10 11 12 13

Math-8 8M v v v - - - - - -
Roman-8 8u v v v - - - - - -
WiE.Europe 9E v v v - - - - - -
Pc1004 9J v v v - - - - - -
8859-15ISO 9N v v v - - - - - -
PcTk437 9T v v v - - - - - ,
Windows 9u v v v - - - - - -
PsText 10J v v v - - - - - -
IBM-US 10U v/ v v - - - . - -
IBM-DN 11U v v v - - - - - -
McText 12) v v v - - - - - -
PcMultiling 12U v v v - - - - - -
Velnternati 13J v v v - - - - - .
PcEur858 13U v v v - - - - - -
VeUsS 14) v/ v v - - - - - -
PiFont 15U v v v - - - - - -
PcE.Europe 17U v v v - - - - - -
Unicode 3.0 18N v v v - - - - - -
WiBALT 19L v v v - - - - - -
WiAnsi 19U v v v - - - - - -
PcBIt775 26U v v v - - - - - -
Pc866Cyr 3R v v - - - - - - -
Greek8 8G v v - - - - - - -
WinGrk 9G v v - - - - - - -
WinCyr 9R v v - - - - - - -
Pc851Grk 10G v v - - - - - - -
ISOCyr 10N v v - - - - - - -
Pc8Grk 12G v v - - - - - - -
ISOGrk 12N v v - - - - . - -
Pc866Ukr 14R v v - - - - - - -
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Symbol Set Attribute Font Classification
Name

1 2 3 4 5 6 7 8 9 10 11 12 13
Hebrew7 OH v - - - - - v - - - - - -
8859-81SO 7H | - - - - . v | - B . . . .
Hebrew8 8H v - - - - - v - - - - - _
Pc862Heb 15H Vo o- - - - - v ol . - _ - .
PC-862, 15Q | - - - - . v |- B . . . .
Hebrew
Arabic8 8V - - - - - - - v/ - - - - -
HPWARA 9V - - - - - - . o o- - - _ .
Pc864Ara 10V - - - - - - - v - - - - -
Symbol 19M - - - v - - - - - - - - -
Wingdings 579L - - - - v - - - - - - - -
ZapfDigbats 14L - - - - - v - - - - - - -
OCRA 00 - - - - - - - - - V4 - - ,
OCRB 10 - - - - - - - - - - v - -
OCRB 3Q - - - - - - - - - - v - -
Extension
Code3-9 oy - - - - - - - - - - - 4 -
EAN/UPC 8Y - - - - - - - - . - - - 4

Installing the Optional Units

Optional Paper Cassette Unit Code

The following is the code for the optional paper cassette unit.

Optional Cassette Unit (C12C932871)
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Installing the Optional Paper Cassette Units

A Caution:

(A Make sure you turn off the printer, unplug the power cord from the printer, and disconnect any cables before
starting installation. Otherwise, the power cord may be damaged resulting in fire or electric shock.

[ When lifting the printer, place your hands in the positions shown below. If you lift the printer holding other
positions, the printer may fall or you may trap your fingers when placing the printer.

1. Turn off the printer by pressing the Q) button, and then unplug the power cord.

2. Disconnect any connected cables.

3. Remove the optional paper cassette unit from its box, and then remove any protective materials.
4. Place the optional paper cassette unit where you want to set up the printer.

5. Lower the printer onto the optional paper cassette unit.
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6. DPlace the sticker indicating the cassette number.

7. Reconnect the power cord and any other cables, and then plug in the printer.

8. Turn on the printer by pressing the O button.

9. Pull out and reinsert the optional paper cassette unit to check that the optional paper cassette unit is displayed
on the Paper Setting screen.

Note:
When uninstalling the optional paper cassette unit, turn off the printer, unplug the power cord, disconnect any cables,
and then perform the installation procedure in reverse.

Proceed with the printer driver settings.

Related Information

= “Optional Paper Cassette Unit Code” on page 130

Setting the Optional Paper Cassette Unit in the Printer Driver

To use the installed optional paper cassette unit, the printer driver needs to acquire the necessary information.

Setting the Optional Paper Cassette Unit in the Printer Driver - Windows

Note:
Log on to your computer as an administrator.

1. Open the Optional Settings tab from the printer properties.
[ Windows 10/Windows Server 2016

Right-click on the start button, or press and hold it and then select Control Panel > View devices and
printers in Hardware and Sound. Right-click on your printer, or press and hold it, select Printer
properties, and then click the Optional Settings tab.

J Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer, or press and hold it, select Printer properties, and then click the Optional Settings
tab.
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[ Windows 7/Windows Server 2008 R2

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.
Right-click on your printer, select Printer properties, and then click the Optional Settings tab.

[ Windows Vista/Windows Server 2008

Click the start button, and then select Control Panel > Printers in Hardware and Sound. Right-click on
your printer, select Property, and then click Optional Settings.

[ Windows XP/Windows Server 2003 R2/Windows Server 2003

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes.
Right-click on your printer, select Property, and then click the Optional Settings tab.

2. Select Acquire from Printer, and then click Get.

Optional Paper Sources information is displayed in Current Printer Information.

3. Click OK.

Setting the Optional Paper Cassette Unit in the Printer Driver - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver).

2. Set Lower Cassette according to the number of paper cassettes.

3. Click OK.

Regulatory Information

Standards and Approvals

Standards and Approvals for U.S. Model

Safety UL60950-1
CAN/CSA-C22.2 N0.60950-1

EMC FCC Part 15 Subpart B Class B

CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module.
Manufacturer: Askey Computer Corporation
Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not cause
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harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject
to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio
frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least
7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

Standards and Approvals for European Model

For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.

http://www.epson.eu/conformity
B651A

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

C€

Standards and Approvals for Australian Model

EMC AS/NZS CISPR32 Class B

Epson hereby declares that the following equipment Models are in compliance with the essential requirements and
other relevant provisions of AS/NZS4268:

B651A

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

German Blue Angel

See the following website to check whether or not this printer meets the standards for the German Blue Angel.

http://www.epson.de/blauerengel

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.
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Copying of the following items is prohibited by law:

[ Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

[J Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

[d Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

[J Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

[ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting the Printer

When you need to transport the printer to move or for repairs, follow the steps below to pack the printer.

A Caution:

1 When carrying the printer, lift it using a stable position. Lifting the printer using an unstable position may result
in injury.

[ Because this printer is heavy, it should always be carried by two or more people when unpacking and
transporting.

1 When lifting the printer, place your hands in the positions shown below. If you lift the printer holding other
positions, the printer may fall or you may trap your fingers when placing the printer.

(d When carrying the printer, do not tilt it more than 10 degrees; otherwise the printer may fall.
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n Important:

 When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

[ Leave the ink supply units installed. Removing the ink supply units can dry out the print head and may prevent
the printer from printing.

1. Turn off the printer by pressing the O button.

2. Make sure the power light turns off, and then unplug the power cord.

n Important:

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.
4. Ifthe printer supports external storage devices, make sure they are not connected.
5. Remove all of the paper from the printer.

6. Open the printer cover. Secure the print head to the case with tape.

\

AW\

fé\““
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7. Close the printer cover.

8. Uninstall the optional paper cassette if it is installed.
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9. Prepare tO paCk the printer as ShOV\/n belo W.
}Q
o

10. Remove the output tray from the printer.

11. Pack the printer in its box, using the protective materials.

oy
=

When you use the printer again, make sure you remove the tape securing the print head. If print quality has
declined the next time you print, clean and align the print head.

Related Information
= “Checking and Cleaning the Print Head” on page 88
= “Aligning the Print Head” on page 89

Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.
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Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2017 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.

Trademarks

[ EPSONG® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

(d The N-Mark is a trademark or registered trademark of NFC Forum, Inc. in the United States and in other
countries.

[J QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.

J Microsoft®, Windows®, Windows Server®, and Windows Vista® are registered trademarks of Microsoft
Corporation.

[d Apple, Macintosh, macOS, OS X, Bonjour, ColorSync, Safari, AirPrint, the AirPrint Logo, iPad, iPhone, iPod
touch, and iTunes are trademarks of Apple Inc., registered in the U.S. and other countries.

[d Google Cloud Print, Chrome, Chrome OS, Google Play and Android are trademarks of Google Inc.

[J Adobe, the Adobe logo, Acrobat, Photoshop, PostScript®3™, and Reader are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

4 Albertus, Arial, Coronet, Gill Sans, Joanna and Times New Roman are trademarks of The Monotype
Corporation registered in the United States Patent and Trademark Office and may be registered in certain
jurisdictions.

(4 ITC Avant Garde Gothic, ITC Bookman, Lubalin Graph, Mona Lisa, ITC Symbol, Zapf Chancery and Zapf
Dingbats are trademarks of International Typeface Corporation registered in the U.S. Patent and Trademark
Office and may be registered in certain other jurisdictions.

[ Clarendon, Eurostile and New Century Schoolbook are trademarks of Linotype GmbH registered in the U.S.
Patent and Trademark Office and may be registered in certain other jurisdictions.

[J Wingdings is a registered trademark of Microsoft Corporation in the United States and other countries.

d CG Omega, CG Times, Garamond Antiqua, Garamond Halbfett, Garamond Kursiv, Garamond Halbfett Kursiv
are trademarks of Monotype Imaging, Inc. and may be registered in certain jurisdictions.

(4 Antique Olive is a trademark of M. Olive.
(d Marigold and Oxford are trademarks of AlphaOmega Typography.

[d Helvetica, Optima, Palatino, Times and Univers are trademarks of Linotype Corp. registered in the U.S. Patent
and Trademark Office and may be registered in certain other jurisdictions in the name of Linotype Corp. or its
licensee Linotype GmbH.

[d PCL is the registered trademark of Hewlett-Packard Company.
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4 Arcfour
This code illustrates a sample implementation of the Arcfour algorithm.
Copyright © April 29, 1997 Kalle Kaukonen. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
this copyright notice and disclaimer are retained.

THIS SOFTWARE IS PROVIDED BY KALLE KAUKONEN AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL KALLE KAUKONEN OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

(J microSDHC Logo is a trademark of SD-3C, LLC.

Note: microSDHC is built into the product and cannot be removed.

icro”
mige3

[d General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.

Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.

Contacting Epson Support

Before Contacting Epson
If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting

information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.
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Epson support will be able to help you much more quickly if you give them the following information:

[ Product serial number

(The serial number label is usually on the back of the product.)
4 Product model

[ Product software version

(Click About, Version Info, or a similar button in the product software.)
(d Brand and model of your computer
(J Your computer operating system name and version

[d Names and versions of the software applications you normally use with your product

Note:

Depending on the product, network settings may be stored in the product’s memory. Due to breakdown or repair of a
product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings
even during a warranty period. We recommend that you make your own backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:

World Wide Web
http://www.epson.com.tw

Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk

Phone: +886-2-80242008

Our HelpDesk team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problems

[J Enquiries on repair service and warranty

Repair service center:
http://www.tekcare.com.tw/branchMap.page

TekCare corporation is an authorized service center for Epson Taiwan Technology & Trading Ltd.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product manuals,
we provide the following sources for obtaining information:
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Internet URL
http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The
site provides a download area for drivers, Epson contact points, new product information and technical support (e-
mail).

Epson Helpdesk
Phone: 1300-361-054

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product manuals, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation.

Help for Users in New Zealand

Epson New Zealand wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:

Internet URL
http://www.epson.co.nz

Access the Epson New Zealand World Wide Web pages. Worth taking your modem here for the occasional surf!
The site provides a download area for drivers, Epson contact points, new product information and technical
support (e-mail).

Epson Helpdesk
Phone: 0800 237 766

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation.
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Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web
http://www.epson.com.sg

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.

Epson HelpDesk

Toll Free: 800-120-5564

Our HelpDesk team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problem troubleshooting

[J Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web
http://www.epson.co.th

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are
available.

Epson Call Centre

Phone: 66-2685-9899

Email: support@eth.epson.co.th

Our Call Centre team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problems

(d Enquiries on repair service and warranty

Help for Users in Vietnam

Contacts for information, support, and services are:

Epson Service Center

65 Truong Dinh Street, District 1, Hochiminh City, Vietnam.
Phone(Ho Chi Minh City): 84-8-3823-9239, 84-8-3825-6234
29 Tue Tinh, Quan Hai Ba Trung, Hanoi City, Vietnam
Phone(Hanoi City): 84-4-3978-4785, 84-4-3978-4775
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Contacts for information, support, and services are:

World Wide Web

http://www.epson.co.id

(d Information on product specifications, drivers for download

[ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline
Phone: +62-1500-766
Fax: +62-21-808-66-799

Our Hotline team can help you with the following over the phone or fax:

[ Sales enquiries and product information

(4 Technical support

Epson Service Center

Province Company Name Address Phone
E-mail
DKI JAKARTA ESS JAKARTA Ruko Mall Mangga Dua No. 48 JI. Arteri (+6221) 62301104

MANGGADUA

Mangga Dua, Jakarta Utara - DKI JAKARTA

jkt-admin@epson-indonesia.co.id

NORTH ESC MEDAN
SUMATERA

JI. Bambu 2 Komplek Graha Niaga Nomor
A-4, Medan - North Sumatera

(+6261) 42066090 / 42066091

mdn-adm@epson-indonesia.co.id

WEST JAWA ESC BANDUNG

JI. Cihampelas No. 48 A Bandung Jawa
Barat 40116

(+6222) 4207033

bdg-admin@epson-
indonesia.co.id

DI ESC YOGYAKARTA YAP Square, Block A No. 6 JI. C Simanjutak (+62274) 581065

YOGYAKARTA Yogyakarta - DIY . . . .
ygy-admin@epson-indonesia.co.id

EAST JAWA ESC SURABAYA Hitech Mall Lt. 2 Block A No. 24 JI. Kusuma (+6231) 5355035

No.116- 11 - JATIM
Bangsa No. 116 8 Surabaya - J sby-admin@epson-indonesia.co.id

SOUTH ESC MAKASSAR JI. Cendrawasih NO. 3A, kunjung mae, (+62411) 8911071

SULAWESI mariso, MAKASSAR - SULSEL 90125 .
mksr-admin@epson-
indonesia.co.id

WEST ESC PONTIANAK Komp. A yani Sentra Bisnis G33, JIl. Ahmad (+62561) 735507 / 767049

KALIMANTAN Yani - Pontianak Kalimantan Barat . .
pontianak-admin@epson-
indonesia.co.id

RIAU ESC PEKANBARU JI. Tuanku Tambusai No.459A Pekanbaru (+62761) 8524695

Riau

pkb-admin@epson-
indonesia.co.id
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Province Company Name Address Phone
E-mail
DKI JAKARTA ESS JAKARTA Wisma Keiai Lt. 1 JI. Jenderal Sudirman Kav. (+6221) 5724335
SUDIRMAN 3 Jakarta Pusat - DKI JAKARTA 10220 . . .
ess@epson-indonesia.co.id
EAST JAWA ESS SURABAYA Ruko Surya Inti JI. Jawa No 2-4 Kav. 29 (+6231) 5014949

Surabaya - Jawa Timur
! y wa fimu esssby@epson-indonesia.co.id

BANTEN ESS SERPONG Ruko Mall WTC Matahari No. 953, Serpong- (+6221) 53167051 /53167052

Banten . . .
esstag@epson-indonesia.co.id

CENTRAL ESS SEMARANG Komplek Ruko Metro Plaza Block C20 JI. MT (+6224) 8313807 / 8417935
JAWA Haryono No 970 Semarang - JAWA TENGAH . . .

esssmg@epson-indonesia.co.id
EAST ESC SAMARINDA JI. KH. Wahid Hasyim (M. Yamin) Kelurahan (+62541) 7272904
KALIMANTAN Sempaja Selatan Kecamatan Samarinda

UTARA - SAMARINDA - KALTIM escsmd@epson-indonesia.co.id

SOUTH ESC PALEMBANG JI. H.M Rasyid Nawawi No. 249 Kelurahan 9 (+62711) 311330

SUMATERA llir Palembang Sumatera Selatan . . .
escplg@epson-indonesia.co.id

EAST JAVA ESC JEMBER JL. Panglima Besar Sudirman Ruko no.1D (+62331) 488373 / 486468
Jember-Jawa Timur (Depan Balai Penelitian

& Pengolahan Kakao) jmr-admin@epson-indonesia.co.id

NORTH ESC MANADO Tekno Megamall Lt LG 11 TK 21, Kawasan (+62431) 8890996
SULAWESI Megamas Boulevard, JI Piere Tendean,

Manado - SULUT 95111 MND-ADMIN@EPSON-

INDONESIA.CO.ID

For other cities not listed here, call the Hot Line: 08071137766.

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.

Internet Home Page
http://www.epson.com.hk

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users
with the following information:

d Product information
4 Answers to Frequently Asked Questions (FAQs)

[ Latest versions of Epson product drivers

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:
Phone: 852-2827-8911

Fax: 852-2827-4383
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Help for Users in Malaysia

Contacts for information, support, and services are:

World Wide Web
http://www.epson.com.my
(d Information on product specifications, drivers for download

[ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Call Centre

Phone: +60 1800-8-17349

[ Sales enquiries and product information
[d Product usage questions or problems

[d Enquiries on repair services and warranty

Head Office
Phone: 603-56288288
Fax: 603-5628 8388/603-5621 2088

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines
Corporation at the telephone, fax numbers and e-mail address below:

World Wide Web
http://www.epson.com.ph

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail
Enquiries are available.

Epson Philippines Customer Care

Toll Free: (PLDT) 1-800-1069-37766

Toll Free: (Digital) 1-800-3-0037766

Metro Manila: (+632)441-9030

Web Site: https://www.epson.com.ph/contact

E-mail: customercare@epc.epson.som.ph

Accessible 9am to 6pm, Monday through Saturday (Except public holidays)
Our Customer Care team can help you with the following over the phone:
[ Sales enquiries and product information

[d Product usage questions or problems

[J Enquiries on repair service and warranty
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Epson Philippines Corporation
Trunk Line: +632-706-2609
Fax: +632-706-2663
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